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Introduction

Welcome to Microsoft Excel 2010 On Demand, a visual quick
reference book that shows you how to work efficiently with
Microsoft Excel.  This book provides complete coverage of
basic to advanced Excel skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Excel 2010, just look for
the icon: New!. The new icon appears in the table of contents
and throughout this book so you can quickly and easily iden-
tify a new or improved feature in Excel 2010. A complete
description of each new feature appears in the New Features
guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
Ctrl+P, as a quicker alternative to using the mouse. A com-
plete list of keyboard shortcuts is available on the Web 
at www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshops

Microsoft Certified Applications
Specialist

Get More on the Web

www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com


Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshops. You start each
project with a sample file, work
through the steps, and then com-
pare your results with a project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Microsoft Certified
Applications Specialist
This book prepares you for the
Microsoft Certified Applications
Specialist (MCAS) exam for
Microsoft Excel 2010 program.
Each MCAS certification exam has
a set of objectives, which are
organized into broader skill sets.
To prepare for the certification
exam, you should review and per-
form each task identified with a
MCAS objective to confirm that
you can meet the requirements for
the exam. Information about the
MCAS program is available in the
back of this book. The MCAS
objectives and the specific pages
that cover them are available on
the Web at www.perspection.com.

The Workshops
walks you
through in-depth
projects to help
you put Microsoft
Excel to work.

Introduction xix

Logo indicates a
task fulfills one
or more MCAS
certification
objectives.

www.perspection.com
www.perspection.com


xx Introduction

Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Excel 2010. Some of the informa-
tion includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

More Content
◆ Photographs. Download

photographs and other
graphics to use in your Office
documents.

◆ More Content. Download
new content developed after
publication. For example,
you can download a
complete chapter on Groove
or SharePoint Workspaces.

You can access these additional
resources on the Web at
www.perspection.com.

Additional content 
is available on the
Web. You can
download a chapter
on Groove or
SharePoint
workspaces.

www.perspection.com


Working with Formulas
and Functions

Introduction

Once you enter data in a worksheet, you’ll want to add for-
mulas to perform calculations. Microsoft Excel can help you
get the results you need. Formulas can be very basic entries
to more complex ones. The difficulty of the formula depends
on the complexity of the result you want from your data. For
instance, if you are simply looking to total this months sales,
then the formula would add your sales number and provide
the result. However, if you were looking to show this months
sales, greater than $100.00 with repeat customers, you would
take a bit more time to design the formula.

Because Microsoft Excel automatically recalculates formu-
las, your worksheets remain accurate and up-to-date no mat-
ter how often you change the data. Using absolute cell
references anchors formulas to a specific cell. Excel provides
numerous built-in functions to add to your worksheet calcula-
tions. Functions, such as AVERAGE or SUM, allow you to per-
form a quick formula calculation. 

Another way to make your formulas easier to understand
is by using name ranges in them. Name ranges—a group of
selected cells named as a range—can help you understand
your more complicated formulas. It is a lot easier to read a
formula that uses name ranges, then to look at the formula
and try to decipher it. Excel offers a tool to audit your work-
sheet. Looking at the “flow” of your formula greatly reduces
errors in the calculation. You can see how your formula is
built, one level at a time through a series of arrows that point
out where the formula is pulling data from. As you develop
your formula, you can make corrections to it. 3

3
What You’ll Do

Understand Formulas

Create and Edit Formulas

Understand Cell Referencing

Use Absolute Cell References

Use Mixed and 3-D Cell References

Name Cells and Ranges

Enter and Manage Names

Simplify a Formula with Ranges

Display Calculations with the Status Bar

Calculate Totals with AutoSum

Perform One Time Calculations

Convert Formulas and Values

Correct Calculation Errors

Correct Formulas

Audit a Worksheet

Locate Circular References

Perform Calculations Using Functions

Create Functions and Nested Functions

Calculate Multiple Results

Use Constants and Functions in Names

71
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Introduction
A formula calculates values to return a result.
On an Excel worksheet, you can create a for-
mula using constant values (such as 147 or
$10.00), operators (shown in the table), refer-
ences, and functions. An Excel formula
always begins with the equal sign (=). 

A constant is a number or text value that
is not calculated, such as the number 147, the
text “Total Profits”, and the date 7/22/2010. On
the other hand, an expression is a value that
is not a constant. Constants remain the same
until you or the system change them. An
operator performs a calculation, such as +
(plus sign) or - (minus sign). A cell reference
is a cell address that returns the value in a
cell. For example, A1 (column A and row 1)
returns the value in cell A1 (see table below).

A function performs predefined calcula-
tions using specific values, called arguments.
For example, the function SUM(B1:B10)
returns the sum of cells B1 through B10. An

argument can be numbers, text, logical values
such as TRUE or FALSE, arrays, error values
such as #NA, or cell references. Arguments
can also be constants, formulas, or other
functions, known as nested functions. A func-
tion starts with the equal sign (=), followed by
the function name, an opening parenthesis,
the arguments for the function separated by
commas, and a closing parenthesis. For
example, the function, AVERAGE(A1:A10,
B1:B10), returns a number with the average
for the contents of cells A1 through A10 and
B1 through B10. As you type a function, a
ToolTip appears with the  structure and argu-
ments needed to complete the function. You
can also use the Insert Function dialog box to
help you add a function to a formula.

Perform Calculations
By default, every time you make a change to
a value, formula, or name, Excel performs a 
calculation. To change the way Excel performs
calculations, click the Formulas tab, click the
Calculation Options button, and then click the
option you want: Automatic, Automatic
Except Data Tables, or Manual. To manually
recalculate all open workbooks, click the
Calculate Now button (or press F9). To recalcu-
late the active worksheet, click the Calculate
Sheet button (or press Shift+F9).

Precedence Order
Formulas perform calculations from left to
right, according to a specific order for each
operator. Formulas containing more than one
operator follow precedence order: exponenti-
ation, multiplication and division, and then
addition and subtraction. So, in the formula 2
+ 5 * 7, Excel performs multiplication first and
addition next for a result of 37. Excel calcu-
lates operations within parentheses first. The
result of the formula (2 + 5) * 7 is 49.

Understanding Formulas

Reference Meaning

A1 Cell in column A and row 1

A1:A10 Range of cells in column A and 
rows 1 through 10

A1:F1 Range of cells in row 1 and 
columns A through F

1:1 All cells in row 1

1:5 All cells in rows 5 through 10

A:A All cells in column A

A:F All cells in columns A through F

Profits!A1:A10 Range of cells in column A and 
rows 1 through 10 in worksheet
named Profits

Cell Reference Examples
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Operator Meaning Example

Arithmetic

= (plus sign) Addition 2+7

- (minus sign) Subtraction 7-2
Negative -2

* (asterisk) Multiplication 2*7

/ (forward slash) Division 7/2

% (percent) Percent 70%

^ (caret) Exponentiation 2^7

Comparison

= (equal sign) Equal to A2=B7

> (greater than sign) Greater than A2>B7

< (less than sign) Less than A2<B7

>= (greater than or equal to sign) Greater than or equal to A2>=B7

<= (less than or equal to sign) Less than or equal to A2<=B7

<> (not equal to sign) Not equal to A2<>B7

Text concatenation

& (ampersand) Connects, or concatenates, two values “Total”&”Profit”
to produce one continuous text value

Reference

: (colon) Range operator, which produces one A1:A10
reference to all the cells between
two references

, (comma) Union operator, which combines multiple SUM(A1:A10,B1:B10)
references into one reference

(space) Intersection operator, which produces A1:A10 B1:B10
on reference to cells common to the 
two references

Types of Operators



A formula calculates values to return a result. On an Excel worksheet,
you can create a formula using values (such as 147 or $10.00), arith-
metic operators (shown in the table), and cell references. An Excel for-
mula always begins with the equal sign (=). The equal sign, when
entered, automatically formats the cell as a formula entry. The best way
to start a formula is to have an argument. An argument is the cell refer-
ences or values in a formula that contribute to the result. Each function
uses function-specific arguments, which may include numeric values,
text values, cell references, ranges of cells, and so on. To accommo-
date long, complex formulas, you can resize the formula bar to prevent
formulas from covering other data in your worksheet. By default, only
formula results are displayed in a cell, but you can change the view of
the worksheet to display formulas instead of results.

74 Chapter 3

Creating a Simple
Formula

Enter a Formula

Click the cell where you want to
enter a formula.

Type = (an equal sign). If you do
not begin with an equal sign, Excel
will display, not calculate, the
information you type. 

Enter the first argument. An
argument can be a number or a
cell reference.

TIMESAVER To avoid typing
mistakes, click a cell to insert its
cell reference in a formula rather
than typing its address.

Enter an arithmetic operator.

Enter the next argument.

Repeat steps 4 and 5 as needed to
complete the formula.

Click the Enter button on the
formula bar, or press Enter. 

Notice that the result of the
formula appears in the cell (if you
select the cell, the formula itself
appears on the formula bar).

TIMESAVER To wrap text in a
cell, press Alt+Enter, which
manually inserts a line break.

7

6

5

4

3

2

1

Understanding Order of Precedence
Formulas containing more than one operator follow the order of
precedence: exponentiation, multiplication and division, and then
addition and subtraction. So, in the formula 5 + 2 * 3, Excel performs
multiplication first and addition next for a result of 11. Excel calcu-
lates operations within parentheses first. The result of the formula (5
+ 2) * 3 is 21.

For Your Information

Formula bar7 1

2

3 5

4
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Resize the Formula Bar

◆ To switch between expanding the
formula box to three or more lines
or collapsing it to one line, click
the double-down arrow at the end
of the formula bar. You can also
press Ctrl+Shift+U.

◆ To precisely adjust the height of
the formula box, point to the
bottom of the formula box until the
pointer changes to a vertical
double arrow, and then drag up or
down, and then click the vertical
double arrow or press Enter.

◆ To automatically fit the formula box
to the number of lines of text in the
active cell, point to the formula
box until the pointer changes to a
vertical double arrow, and then
double-click the vertical arrow.

Display Formulas in Cells

Click the Formulas tab.

Click the Show Formulas button.

TIMESAVER Press Ctrl+’.

To turn off formula display, click
the Show Formulas button again.

3

2

1

Double-down arrow

21

Did You Know?
Pointing to cells reduces errors. When
building formulas, pointing to a cell
rather than typing its address ensures
that the correct cell is referenced.
You can print formulas. Click the
Formulas tab, click the Show Formulas
button to show formulas, click the File
tab, click Print, and then click Print.
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To minimize typing and syntax errors, you can create and edit formulas
with Formula AutoComplete. After you type an = (equal sign) and begin
typing to start a formula, Excel displays a dynamic drop-down list of
valid functions, arguments, defined names, table names, special item
specifiers—including [ (open bracket), , (comma), : (colon)—and text
string that match the letters you type. An argument is the cell refer-
ences or values in a formula that contribute to the result. Each function
uses function-specific arguments, which may include numeric values,
text values, cell references, ranges of cells, and so on.

Creating a Formula
Using Formula
AutoComplete

Enter Items in a Formula Using
Formula AutoComplete

Click the cell where you want to
enter a formula.

Type = (an equal sign), and
beginning letters or a display
trigger to start Formula
AutoComplete.

For example, type su to display all
value items, such as SUBTOTAL
and SUM.

The text before the insertion point
is used to display the values in the
drop-down list.

As you type, a drop-down
scrollable list of valid items is
displayed.

Icons represent the type of entry,
such as a function or table
reference, and a ScreenTip
appears next to a selected item.

To insert the selected item in the
drop-down list into the formula,
press Tab or double-click the item.
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Did You Know?
You can turn on Formula
AutoComplete. Click the File tab, click
Options, click Formulas in the left pane,
select the Formula AutoComplete
check box, and then click OK.
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Use the Keyboard to Navigate

Using the keyboard, you can navigate
the Formula AutoComplete drop-down
list to quickly find the entry you want.

◆ Refer to the table for keyboard
shortcuts for navigating the
Formula AutoComplete drop-down
list.

Turn on Formula AutoComplete

Click the File tab, and then click
Options.

In the left pane, click Formulas.

Select the Formula AutoComplete
check box.

Click OK.4

3

2

1

Press This Key To Move

Left arrow Move the insertion point to the left

Right arrow Move the insertion point to the right

Up arrow Move the selection up one item

Down arrow Move the selection down one item

End Select the last item

Home Select the first item

Page Down Move down one page and select a new item

Page Up Move up one page and select a new item

Esc Close the drop-down list

Alt+Down arrow Turn on or off Formula AutoComplete

4

2

3

Keys For Navigating AutoComplete List

Did You Know?
Some items don’t appear on the
Formula AutoComplete drop-down list.
Defined names that you create for enu-
merated constants, such as the ones
used in the SUBTOTAL function, and
Cube function connections do not
appear in the Formula AutoComplete
drop-down list, but you can still type
them.
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You can edit formulas just as you do other cell contents, using the for-
mula bar or working in the cell. You can select, cut, copy, paste, delete,
and format cells containing formulas just as you do cells containing
labels or values. Using AutoFill, you can quickly copy formulas to adja-
cent cells. If you need to copy formulas to different parts of a work-
sheet, use the Paste command or Paste Options button.

Editing a Formula

Edit a Formula Using the
Formula Bar

Select the cell that contains the
formula you want to edit.

Press F2 to change to Edit mode.

If necessary, use the Home, End,
and arrow keys to position the
insertion point within the cell
contents.

Use any combination of
Backspace and Delete to erase
unwanted characters, and then
type new characters as needed.

Click the Enter button on the
formula bar, or press Enter.

Copy a Formula Using AutoFill

Select the cell that contains the
formula you want to copy. 

Position the pointer (fill handle) on
the lower-right corner of the
selected cell.

Drag the mouse down until the
adjacent cells where you want the
formula pasted are selected, and
then release the mouse button.

3

2

1

5

4

3

2

1

1

5

2 Edit mode

2

3
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Fill
handle



Chapter 3 Working with Formulas and Functions 79

Copy and Paste a Formula

Select the cell that contains the
formula you want to copy.

Click the Home tab.

Click the Copy button.

Select one or more cells where
you want to paste the formula.

Click the Paste button or click the
Paste button arrow, point to an
option to display a live preview
(New!) of the paste, and then
click to paste the item.

Click the Paste Options button,
point to an option for the live
preview (New!), and then select
the option you want.

If you don’t want to paste this
selection anywhere else, press
Esc to remove the marquee.
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Did You Know?
You can use Paste Special to copy
only formulas. Select the cells contain-
ing the formulas you want to copy,
click the Copy button on the Home tab,
click where you want to paste the
data, click the Paste button arrow,
click Paste Special, click the Formulas
button, and then click OK.

You can use keyboard commands to
recalculate formulas. Press F9 to
recalculate formulas that have
changed since the last calculation in
all open workbooks. Press Shift+F9 to
recalculate formulas in the active
workbook. Press Ctrl+Alt+F9 to recal-
culate all formulas in all open work-
books, regardless of whether formulas
have changed. Press Ctrl+Shift+Alt+F9
to recheck dependent formulas in all
open workbooks, regardless of
whether formulas have changed.
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Each cell, the intersection of a column and
row on a worksheet, has a unique address, or
cell reference, based on its column letter and
row number. For example, the cell reference
for the intersection of column D and row 4 
is D4.

Cell References in Formulas
The simplest formula refers to a cell. If you
want one cell to contain the same value as
another cell, type an equal sign followed by
the cell reference, such as =D4. The cell that
contains the formula is known as a dependent
cell because its value depends on the value in
another cell. Whenever the cell that the for-
mula refers to changes, the cell that contains
the formula also changes.

Depending on your task, you can use rela-
tive cell references, which are references to
cells relative to the position of the formula,
absolute cell references, which are cell refer-
ences that always refer to cells in a specific
location, or mixed cell references, which use a
combination of relative and absolute column
and row references. If you use macros, the
R1C1 cell references make it easy to compute
row and column positions. 

Relative Cell References
When you copy and paste or move a formula
that uses relative references, the references in
the formula change to reflect cells that are in
the same relative position to the formula. The
formula is the same, but it uses the new cells
in its calculation. Relative addressing elimi-
nates the tedium of creating new formulas for
each row or column in a worksheet filled with
repetitive information.

Absolute Cell References
If you don’t want a cell reference to change
when you copy a formula, make it an
absolute reference by typing a dollar sign ($)
before each part of the reference that you
don’t want to change. For example, $A$1
always refers to cell A1. If you copy or fill the
formula down columns or across rows, the
absolute reference doesn’t change. You can
add a $ before the column letter and the row
number. To ensure accuracy and simplify
updates, enter constant values (such as tax
rates, hourly rates, and so on) in a cell, and
then use absolute references to them in for-
mulas.

Mixed Cell References
A mixed reference is either an absolute row
and relative column or absolute column and
relative row. You add the $ before the column
letter to create an absolute column or before
the row number to create an absolute row.
For example, $A1 is absolute for column A
and relative for row 1, and A$1 is absolute for
row 1 and relative for column A. If you copy
or fill the formula across rows or down
columns, the relative references adjust, and
the absolute ones don’t adjust.

3-D References
3-D references allow you to analyze data in
the same cell or range of cells on multiple
worksheets within a workbook. A 3-D refer-
ence includes the cell or range reference, pre-
ceded by a range of worksheet names. For
example, =AVERAGE(Sheet1:Sheet4!A1)
returns the average for all the values con-
tained in cell A1 on all the worksheets
between and including Sheet 1 and Sheet 4. 

Understanding Cell Referencing



When you want a formula to consistently refer to a particular cell, even
if you copy or move the formula elsewhere on the worksheet, you need
to use an absolute cell reference. An absolute cell reference is a cell
address that contains a dollar sign ($) in the row or column coordinate,
or both. When you enter a cell reference in a formula, Excel assumes it
is a relative reference unless you change it to an absolute reference. 
If you want part of a formula to remain a relative reference, remove the
dollar sign that appears before the column letter or row number. 
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Using Absolute Cell
References

Create an Absolute Reference

Click a cell where you want to
enter a formula.

Type = (an equal sign) to begin the
formula.

Select a cell, and then type an
arithmetic operator (+, -, *, or /).

Select another cell, and then press
the F4 key to make that cell
reference absolute. 

You can continue to press F4 to
have Excel cycle through the
different reference types.

If necessary, continue entering the
formula.

Click the Enter button on the
formula bar, or press Enter.
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Did You Know?
You can change an absolute reference
back to a relative reference. In the cell
with the absolute formula, repeatedly
press F4 until all the dollar signs are
removed from the reference. You press
F4 to cycle through all the reference
types. For example, if you enter A1 to
start a formula, press F4 to display
$A$1. Press again to display A$1. Press
again to display $A1. Press it again to
display A1. 

Absolute reference



A mixed cell reference is either an absolute column and relative row or
absolute row and relative column. When you add the $ before the col-
umn letter you create an absolute column or before the row number
you create an absolute row. For example, $A1 is absolute for column A
and relative for row 1, and A$1 is absolute for row 1 and relative for
column A. If you copy or fill the formula across rows or down columns,
the relative references adjust, and the absolute ones don’t adjust.
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Using Mixed Cell
References

Create a Mixed Reference

Click a cell where you want to
enter a formula.

Type = (an equal sign) to begin the
formula.

Select the cells you want to use
and then complete the formula.

Click the insertion point in the
formula bar, and then type $ before
the column or row you want to
make absolute.

Click the Enter button on the
formula bar, or press Enter.
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Mixed reference
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Using 3-D Cell
References

Create a 3-D Cell Reference

Click a cell where you want to
enter a formula.

Type = (an equal sign) to begin the
formula.

Type the function you want to use
followed by a ( (left bracket).

Type the first worksheet name,
followed by a : (colon), and then
the last worksheet name in the
range.

Type ! (exclamation).

Type or select the cell or cell
range you want to use in the
function.

Type ) (right bracket).

Click the Enter button on the
formula bar, or press Enter.
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If you want to analyze data in the same cell or range of cells on multi-
ple worksheets within a workbook, use a mixed 3-D reference. For
example, =SUM(Sheet3:Sheet6!A1:A10) returns the sum for all the val-
ues contained in the range of cells A1 through A10 on all the work-
sheets between and including Sheet 3 and Sheet 6. 3-D references
work with the following functions: AVERAGE, AVERAGEA, COUNT,
COUNTA, MAX, MAXA, MIN, MINA, PRODUCT, STDEV, STDEVA, STDE-
VPA, VAR, VARA, VARP, and VARPA. However, 3-D references cannot
be used with array formulas, the intersection operator (a single space),
or the implicit intersection. If you move, insert, or copy sheets between
the ones included in the range, Excel adds the values from the sheets
in the calculations. If you move or remove sheets between the ones
included in the range, Excel removes the values from the calculation.
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2See Also
See “Performing Calculations Using
Functions” on page 102 and “Creating
Functions” on page 103 for information
on creating and using functions.
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To make working with ranges easier, Excel allows you to name them.
The name BookTitle, for example, is easier to remember than the range
reference B6:B21. Named ranges can be used to navigate large work-
sheets. Named ranges can also be used in formulas instead of typing or
pointing to specific cells. When you name a cell or range, Excel uses
an absolute reference for the name by default, which is almost always
what you want. You can see the absolute reference in the Refers to box
in the New Name dialog box. There are two types of names you can
create and use: defined name and table name. A defined name repre-
sents a cell, a range of cells, formula or constant, while a table name
represents an Excel table, which is a collection of data stored in
records (rows) and fields (columns). You can define a name for use in a
worksheet or an entire workbook, also known as scope. To accommo-
date long names, you can resize the name box in the formula bar. The
worksheet and formula bar work together to avoid overlapping content.

Naming Cells
and Ranges

Name a Cell or Range Using the
Name Box

Select the cell or range, or
nonadjacent selections you want
to name.

Click the Name box on the formula
bar.

Type a name for the range. 

A range name can include up to
255 characters, uppercase or
lowercase letters (not case
sensitive), numbers, and
punctuation, but no spaces or cell
references.

By default, names use absolute
cell references.

To adjust the width of the Name
box, point between the Name box
and the Formula box until the
pointer changes to a horizontal
double arrow, and then drag left 
or right.

Press Enter. The range name will
appear in the Name box whenever
you select the range in the
workbook.
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Let Excel Name a Cell or Range

Select the cells, including the
column or row header, you want to
name.

Click the Formulas tab.

Click the Create from Selection
button.

Select the check box with the
position of the labels in relation to
the cells.

Excel automatically tries to
determine the position of the
labels, so you might not have to
change any options. 

Click OK.

Name a Cell or Range Using the
New Name Dialog Box

Select the cell or range, or
nonadjacent selections you want
to name.

Click the Formulas tab.

Click the Define Name button.

Type a name for the reference.

Click the Scope list arrow, and
then click Workbook or a specific
worksheet.

If you want, type a description of
the name.

The current selection appears in
the Refer to box.

Click the Collapse Dialog button,
select different cells and click the
Expand Dialog button, or type =
(equal sign) followed by a constant
value or a formula.

Click OK.8
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After you define a named cell or range, you can enter a name by typing,
using the Name box, using Formula AutoComplete, or selecting from the
Use in Formula command. As you begin to type a name in a formula,
Formula AutoComplete displays valid matches in a drop-down list,
which you can select and insert into a formula. You can also select a
name from a list of available from the Use in Formula command. If you
have already entered a cell or range address in a formula or function,
you can apply a name to the address instead of re-creating it. 

Entering Named Cells
and Ranges

Enter a Named Cell or Range
Using the Name Box

Click the Name box list arrow on
the formula bar.

Click the name of the cell or range
you want to use. 

The range name appears in the
Name box, and all cells included in
the range are highlighted on the
worksheet.

Enter a Named Cell or Range
Using Formula AutoComplete

Type = (equal sign) to start a
formula, and then type the first
letter of the name.

To insert a name, type the first
letter of the name to display it in
the Formula AutoComplete drop-
down list.

Scroll down the list, if necessary,
to select the name you want, and
then press Tab or double-click the
name to insert it.
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Enter a Named Cell or Range
from the Use in Formula
Command

Type = (equal sign) to start a
formula.

Click the Formulas tab.

When you want to insert a name,
click the Use in Formula button.

Use one of the following menu
options:

◆ Click the name you want to use.

◆ Click Paste Names, select a
name, and then click OK.

Apply a Name to a Cell or Range
Address

Select the cells in which you want
to apply a name.

Click the Formulas tab.

Click the Define Name button
arrow, and then click Apply
Names.

Click the name you want to apply.

Click OK.5

4

3

2

1

4

3

2

1

1

32

4

32

1

4

5

Did You Know?
Should I select the Use row and 
column names option? When you
select this option, Excel uses the range
row and column headings to refer to
the range you’ve selected (if a cell
does not have its own name, but is part
of a named range).
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The Name Manager makes it easy to work with all the defined names
and table names in a workbook from one location. You can display the
value and reference of a name, specify the scope—either worksheet or
workbook level—of a name, find names with errors, and view or edit
name descriptions. In addition, you can add, change, or delete names,
and sort and filter the names list. You can also use table column header
names in formulas instead of cell references. 

Managing Names

Organize and View Names

Click the Formulas tab.

Click the Name Manager button.

TROUBLE? You cannot use the
Name Manager dialog box while
you’re editing a cell. The Name
Manager doesn’t display names
defined in VBA or hidden names.

Use one of the following menu
options:

◆ Resize columns. Double-click
the right side of the column
header to automatically size the
column to fit the largest value
in that column.

◆ Sort names. Click the column
header to sort the list of names
in ascending or descending
order.

◆ Filter names. Click the Filter
button, and then select the filter
command you want. See table
for filter option details.

Click Close.4

3

2

1

Option Result

Names Scoped to Worksheet Displays names local to a worksheet

Names Scoped to Workbook Displays names global to a workbook

Names with Errors Displays names with values that 
contain errors (such as #NAME, 
#VALUE, etc.)

Names without Errors Displays names without errors

Defined Names Displays names defined by you or by 
Excel

Table Names Displays table names

4

3

Column header

Name Manager Filter Options

Did You Know?
What happens when you zoom in on a
name range? When you zoom the view
of the worksheet to 39 percent or less,
Excel adds a blue border around the
labels you have created. The blue bor-
der does not print.
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Change a Name

Click the Formulas tab.

Click the Names Manager button.

Click the name you want to
change.

Click Edit.

Type a new name for the
reference in the Name box.

Change the reference. Enter a
range or use the Collapse button
to select one.

Click OK.

In the Refers to area, make any
changes you want to the cell,
formula, or constant represented
by the name.

To cancel unwanted changes,
click the Cancel button or press
Esc, or to save changes, click the
Commit button or press Enter.

Click Close.9
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Did You Know?
You can delete a name range. Click the
Formulas tab, click the Name Manager
button, select the names you want to
delete, click Delete or press Delete,
click OK to confirm, and then click
Close.

What happens when you change a
label reference? If you change the
name of a reference label, Excel auto-
matically makes the change to every
formula in which the name is used.

You can label names that are relative.
When you use a label name in a for-
mula or function, Excel sees it as a rel-
ative reference. You can copy the
formula to other cells, or use AutoFill to
copy it and the reference changes.
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You can simplify formulas by using ranges and range names. For exam-
ple, if 12 cells on your worksheet contain monthly budget amounts, and
you want to multiply each amount by 10%, you can insert one range
address in a formula instead of inserting 12 different cell addresses, or
you can insert a range name. Using a range name in a formula helps to
identify what the formula does; the formula =TotalOrder*0.10, for exam-
ple, is more meaningful than =SUM(F6:F19)*0.10. 

Simplifying a Formula
with Ranges

Use a Range in a Formula 

Put your cursor where you would
like the formula. Type an equal
sign (=) followed by the start of a
formula, such as =SUM(.

Click the first cell of the range, and
then drag to select the last cell in
the range. Excel enters the range
address for you.

Complete the formula by entering
a close parentheses, or another
function, and then click the Enter
button.

Use a Range Name in a Formula

Put your cursor where you would
like the formula. Type an equal
sign (=) followed by the start of a
formula, such as =SUM(.

Press F3 to display a list of named
ranges.

◆ You can also click the Use in
Formula button on the Formulas
tab, and then click Paste.

Click the name of the range you
want to insert.

Click OK.

Complete the formula by entering
a close parentheses, or another
function, and then click the Enter
button.
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You can simplify your work using the Status bar calculations when you
don’t want to insert a formula, but you want to quickly see the results of
a simple calculation. The Status bar automatically displays the sum,
average, maximum, minimum, or count of the selected values. The
Status bar results do not appear on the worksheet when printed but are
useful for giving you quick answers while you work. If a cell contains
text, it’s ignored, except when you select the Count option.
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Displaying
Calculations with 
the Status Bar

Calculate a Range Automatically

Select the range of cells you want
to calculate. 

The sum, average, and count of
the selected cells appears on the
status bar by default.

If you want to change the type of
calculations that appear on the
Status bar, right-click anywhere on
the Status bar to display a shortcut
menu.

The shortcut menu displays all the
available status information you
can track. The right side of the
menu displays the current values
for the different calculations.

Click to toggle (on or off) the
available types of calculations. 

◆ Average

◆ Count

◆ Numerical Count

◆ Minimum

◆ Maximum

◆ Sum
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A range of cells can easily be added using the AutoSum button on the
Formulas tab. AutoSum suggests the range to sum, although this range
can be changed if it’s incorrect. AutoSum looks at all of the data that is
consecutively entered, and when it sees an empty cell, that is where
the AutoSum stops. You can also use AutoSum to perform other calcu-
lations, such as AVERAGE, COUNT, MAX, and MIN. Subtotals can be
calculated for data ranges using the Subtotals dialog box. This dialog
box lets you select where the subtotals occur, as well as the function
type.

Calculating Totals
with AutoSum

Calculate Totals with AutoSum

Click the cell where you want to
display the calculation.

◆ To sum with a range of
numbers, select the range of
cells you want.

◆ To sum with only some of the
numbers in a range, select the
cells or range you want using
the Ctrl key. Excel inserts the
sum in the first empty cell
below the selected range.

◆ To sum both across and down a
table of number, select the
range of cells with an
additional column to the right
and a row at the bottom.

Click the Formulas tab.

Click the AutoSum button.

TIMESAVER Press Alt+= to
access the AutoSum command.

Click the Enter button on the
formula bar, or press Enter.
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Did You Know?
You can select additional AutoFill
commands. Click the Home tab, and
then click the Fill button to select addi-
tional commands such as Up, Down,
Left, Right, Series, or Justify.
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Calculate with Extended
AutoSum

Click the cell where you want to
display the calculation.

Click the Formulas tab.

Click the AutoSum button arrow. 

Click the function you want to use,
such as AVERAGE, COUNT, MAX,
and MIN.

Press Enter to accept the range
selected.

Calculate Subtotals and Totals 

Click anywhere within the data to
be subtotaled.

Click the Data tab.

Click the Subtotal button.

If a message box appears, read
the message, and then click the
appropriate button. 

Select the appropriate check
boxes to specify how the data is
subtotaled.

Click OK.5
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Did You Know?
You can use AutoSum to calculate a
subtotal. If you’re working with a table,
you can use the AutoSum button to
insert the Subtotal function rather than
the SUM function. The function only
sums the visible cells in a filtered list. 
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Sometimes you may want to perform simple calculations, such as divid-
ing each value in a range by 4, without having to take the time to use a
formula. You can use the Paste Special command to perform simple
mathematical operations, such as Add, Subtract, Multiply, and Divide. If
you want to perform a more complex function, you can create a tempo-
rary formula to accomplish a one-time task. For example, if you want to
display a list of names in proper case with only the first letter of each
name in uppercase, you can use the Proper function.

Performing One Time
Calculations

Perform One Time Simple
Calculations without Using a
Formula

Select an empty cell, and then
enter the number you want to use
in a calculation.

Click the Home tab.

Click the Copy button.

Select the range you want to use
in the calculation.

Click the Paste button arrow, and
then click Paste Special.

Click the operation option you
want to use: Add, Subtract,
Multiply, or Divide.

Click OK.

Press Esc to cancel Copy mode.

The operation is applied to the
contents of each cell in the range.
The formula in each cell is
changed to include the new
operation.
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Perform One Time Calculations
Using a Formula

Create a temporary formula in an
unused cell, typically a column out
of the way. Select an empty cell at
the top, type = (equal sign), and
then type a function, such as
Proper().

Click the Home tab.

If you want to change a range of
data, use the fill down handle to
copy the formula to unused cells.

Select the cell or range with the
formula.

Click the Copy button.

Select the cell you want to change
the contents with the formula.

Click the Paste button arrow, and
then click Paste Special.

Click the Values option.

Click OK.

The original data is replaced with
the changed data.

When you’re done with the
temporary formulas, select the
cells, and delete them.
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If you have a range of cells that contain formulas, you can convert the
cells to values only. This is useful when you have a range of cells that
you don’t want to change anymore. You use the Paste Special com-
mand to paste the contents of the selected range back into place as a
value instead of a formula. If you’re working with an input form in Excel,
you probably need to delete values, but keep the formulas. You can do
it with the help of the Go To Special dialog box. 

Converting Formulas
and Values

Convert a Formula to a Value

Select the range of cells with
formulas you want to convert to
values.

Click the Home tab.

Click the Copy button.

Click the Paste button arrow, and
then click Paste Special.

Click the Values option.

Click OK.

Press Esc to cancel Copy mode.

Delete Values and Keep
Formulas

Click the Home tab.

Click the Find & Select button, and
then click Go To Special.

Click the Constants option.

Select the Numbers check box,
and then clear the other check
boxes under Formula.

Click OK.

Press Delete to remove the
selected values.
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When Excel finds a possible error in a calculation, it displays a green 
triangle in the upper left corner of the cell. If Excel can’t complete a 
calculation it displays an error message, such as “#DIV/0!” or
“#NAME?. You can use the Error Options button to help you fix the
problem. In a complex worksheet, it can be difficult to understand the
relationships between cells and formulas. Auditing tools enable you to
clearly determine these relationships. When the Auditing feature is
turned on, it uses a series of arrows to show you which cells are part
of which formulas. When you use the auditing tools, tracer arrows point
out cells that provide data to formulas and the cells that contain formu-
las that refer to the cells. A box is drawn around the range of cells that
provide data to formulas.

Correcting
Calculation Errors

Review and Correct Errors

Select a cell that contains a green
triangle in the upper left corner.

Click the Error Options button.

Click one of the troubleshooting
options (menu options vary
depending on the error).

◆ To have Excel fix the error, 
click one of the available
options specific to the error.

◆ To find out more about an error,
click Help on this Error.

◆ To evaluate the formula, click
Show Calculation Steps.

◆ To remove the error alert, 
click Ignore Error.

◆ To fix the error manually, 
click Edit in Formula Bar.

◆ To enable background error
checking, specify an error
color, or reset ignored errors,
click Error Checking Options.
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Avoiding Error Displays in Formulas

If you include empty cells in a formula, an error message, such as
#DIV/0! might appear in the formula cell. You can avoid this message by
adding a function to check for errors. If the formula generating an error
message for empty cells is =Formula, then change it to
=IF(ISERROR(Formula),””,Formula). If the ISERROR function is true, the
IF function returns an empty string, instead of an error message.

For Your Information
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Excel has several tools to help you find and correct problems with for-
mulas. One tool is the Watch window and another is the Error checker.
The Watch window keeps track of cells and their formulas as you make
changes to a worksheet. Excel uses an error checker in the same way
Microsoft Word uses a grammar checker. The Error checker uses cer-
tain rules, such as using the wrong argument type, a number stored as
text or an empty cell reference, to check for problems in formulas.

Correcting Formulas

Watch Cells and Formulas

Select the cells you want to
watch.

Click the Formulas tab.

Click the Watch Window button.

Click the Add Watch button on the
Watch Window dialog box. 

Click Add.

Click Close.

Remove Cells from the Watch
Window

Click the Formulas tab.

Click the Watch Window button.

Select the cells you want to
delete. Use the Ctrl key to select
multiple cells.

Click Delete Watch.

Click Close.5
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Set Error Checking Options

Click the File tab, and then click
Options.

In the left pane, click Formulas.

Select the Enable background
error checking check box.

Point to the help icons at the end
of the error checking rule options
to display a ScreenTip describing
the rule. 

Select the error checking rules
check boxes you want to use.

Click OK.

Correct Errors

Open the worksheet where you
want to check for errors.

Click the Formulas tab.

Click the Error Checking button.

The error checker scans the
worksheet for errors, generating
the Error Checking dialog box
every time it encounters an error.

If necessary, click Resume.

Choose a button to correct or
ignore the problem. 

◆ Help on this error.

◆ Show Calculation Steps. Click
Evaluate to see results.

◆ Ignore Error.

◆ Edit in Formula Bar.

◆ Previous or Next.

If necessary, click Close.6
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In a complex worksheet, it can be difficult to understand the relation-
ships between cells and formulas. Auditing tools enable you to clearly
determine these relationships. When the Auditing feature is turned on,
it uses a series of arrows to show you which cells are part of which
formulas. When you use the auditing tools, tracer arrows point out
cells that provide data to formulas and the cells that contain formulas
that refer to the cells. A box is drawn around the range of cells that
provide data to formulas.

Auditing a Worksheet

Trace Worksheet Relationships 

Click the Formulas tab.

Use any of the following options:

◆ Click the Trace Precedents
button to find cells that provide
data to a formula. 

◆ Click the Trace Dependents
button to find out which
formulas refer to a cell. 

◆ Click the Error Checking button
arrow, and then click Trace
Error to locate the problem if a
formula displays an error value,
such as #DIV/0!. 

◆ Click the Remove Arrows
button arrow, and then click
Remove Precedent Arrows,
Remove Dependent Arrows, or
Remove All Arrows to remove
precedent and dependent
arrows.

If necessary, click OK to locate the
problem.

3
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1 21

Trace arrow
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A circular reference occurs when a formula directly or indirectly refers
to its own cell. This causes the formula to use its result in the calcula-
tion, which can create errors. When a workbook contains a circular
reference, Excel cannot automatically perform calculations. You can
use error checking in Excel to locate circular references in a formula,
and then remove them. If you leave them in, Excel calculates each cell
involved in the circular reference by using the results of the previous
iteration. An iteration is a repeated recalculation until a specific
numeric condition is met. By default, Excel stops calculating after 100
iterations or after all values in the circular reference change by less
than 0.001 between iterations, unless you change the Excel option.

Locating Circular
References

Locate a Circular Reference

Click the Formulas tab.

Click the Error Checking button
arrow, point to Circular
References, and then click the first
cell listed in the submenu.

Review the formula cell.

If you cannot figure out if the cell
is the cause of the circular
reference, click the next cell in the
Circular References submenu, if
available.

Continue to review and correct the
circular reference until the status
bar no longer displays the word
“Circular.”
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Did You Know?
You can enable and increase formula
iterations to make a circular reference
work. Click the File tab, click Options,
click Formulas, select the Enable itera-
tive calculation check box, enter the
maximum number of iterations you
want (higher the number, the more time
Excel needs to calculate a worksheet),
and set the maximum amount of
change you want to accept between
calculation results (smaller the number,
the more accurate the results).
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Functions are predesigned formulas that save you the time and trouble
of creating commonly used or complex equations. Excel includes 
hundreds of functions that you can use alone or in combination with
other formulas or functions. Functions perform a variety of calculations,
from adding, averaging, and counting to more complicated tasks, such
as calculating the monthly payment amount of a loan. You can enter a
function manually if you know its name and all the required arguments,
or you can easily insert a function using AutoComplete, which helps
you select a function and enter arguments with the correct format.

Performing
Calculations Using
Functions

Enter a Function

Click the cell where you want to
enter the function.

Type = (an equal sign), type the
name of the function, and then
type ( (an opening parenthesis). 

As you type, you can scroll down
the Formula AutoComplete list,
select the function you want, and
then press Tab.

Type the argument or select the
cell or range you want to insert in
the function, and then type ) (a
closed parenthesis) to complete
the function.

Click the Enter button on the
formula bar, or press Enter. 

Excel will automatically add the
closing parenthesis to complete
the function.
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Function Description Sample

SUM Displays the sum of the =SUM(argument)
argument

AVERAGE Displays the average =AVERAGE(argument) 
value in the argument

COUNT Calculates the number of =COUNT(argument)
values in the argument

PMT Determines the monthly =PMT(argument)
payment of a loan

3

1

24

Commonly Used Excel FunctionsSee Also
See “Creating a Formula Using Formula
AutoComplete” on page 76 for informa-
tion on using Formula AutoComplete.
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Functions are predesigned formulas that save you the time and trouble
of creating commonly used or complex equations. Trying to write a for-
mula that calculates various pieces of data, such as calculating pay-
ments for an investment over a period of time at a certain rate, can be
difficult and time-consuming. The Insert Function feature simplifies the
process by organizing Excel’s built-in formulas, called functions, into
categories so they are easy to find and use. A function defines all the
necessary components (also called arguments) you need to produce a
specific result; all you have to do is supply the values, cell references,
and other variables. You can even combine one or more functions.

1
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Inserting Placeholder Arguments

If you don’t know the cell references you want to use for a function,
you can insert argument names as placeholders, and then fill in the
actual argument later. Press Ctrl+Shift+A after you type the functions
name. Excel uses the arguments names as arguments. For example, 

=VLOOKUP(lookup_value, table_array, col_index_num, range_lookup).

For Your Information

Creating Functions

Enter a Function Using Insert
Function

Click the cell where you want to
enter the function.

Click the Insert Function button on
the Formula bar or click the
Function Wizard button on the
Formulas tab.

Type a brief description that
describes what you want to do in
the Search for a function box, and
then click Go.

If necessary, click a function
category you want to use.

Click the function you want to use.

Click OK.

Enter the cell addresses in the text
boxes. Type them or click the
Collapse Dialog button to the right
of the text box, select the cell or
range using your mouse, and then
click the Expand Dialog button.

Click OK.8
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To make it easier to find the function you need for a specific use, Excel
has organized functions into categories—such as Financial, Logical,
Text, Date & Time, Lookup & Reference, Math & Trig, and other func-
tions—on the Formulas tab. Functions—such as beta and chi-squared
distributions—for the academic, engineering, and scientific community
have been improved for more accuracy (New!). Some statistical func-
tions have been renamed for consistency with the real world (New!). If
you want to use an older version of a function for backwards compatibil-
ity with those who do not have Excel 2010, you can use the old functions
on the Compatibility menu (New!) by using the More Functions button.
After you use a function, Excel places it on the recently used list. When
you insert a function from the Function Library, Excel inserts the function
in the formula bar and opens a Function Argument dialog box, where you
can enter or select the cells you want to use in the function.

Creating Functions
Using the Library

Enter a Function Using the
Function Library

Click the cell where you want to
enter the function.

Click the Formulas tab.

Type = (an equal sign).

Click the button (Financial,
Logical, Text, Date & Time, Lookup
& Reference, Math & Trig, More
Functions, or Recently Used) from
the Function Library with the type
of function you want to use, click a
submenu if necessary, and then
click the function you want to
insert into a formula.

Excel inserts the function you
selected into the formula bar with
a set of parenthesis, and opens
the Function Arguments dialog
box.

Type the argument or select the
cell or range you want to insert in
the function. 

You can click the Collapse Dialog
button to the right of the text box,
select the cell or range using your
mouse, and then click the Expand
Dialog button. 

Click OK.6
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An array formula can perform multiple calculations and then return
either a single or multiple result. For example, when you want to count
the number of distinct entries in a range, you can use an array formula,
such as {=SUM(1/COUNTIF(range,range))}. You can also use an array
formula to perform a two column lookup using the LOOKUP function. An
array formula works on two or more sets of values, known as array
arguments. Each argument must have the same number of rows and
columns. You can create array formulas in the same way that you cre-
ate other formulas, except you press Ctrl+Shift+Enter to enter the for-
mula. When you enter an array formula, Excel inserts the formula
between {  } (brackets).

Calculating Multiple
Results

Create an Array Formula

Click the cell where you want to
enter the array formula.

Click the Formulas tab.

Type = (an equal sign).

Use any of the following methods
to enter the formula you want. 

◆ Type the function.

◆ Type and use Formula
AutoComplete.

◆ Use the Function Wizard.

◆ Use button in the Function
Library.

Press Ctrl+Shift+Enter.

{  } (brackets) appear around the
function to indicate it’s an array
formula.
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A nested function uses a function as one of the arguments. Excel
allows you to nest up to 64 levels of functions. Users typically create
nested functions as part of a conditional formula. For example, 
IF(AVERAGE(B2:B10)>100,SUM(C2:G10),0). The AVERAGE and SUM
functions are nested within the IF function. The structure of the IF func-
tion is IF(condition_test, if_true, if_false). You can use the AND, OR,
NOT, and IF functions to create conditional formulas. When you create
a nested formula, it can be difficult to understand how Excel performs
the calculations. You can use the Evaluate Formula dialog box to help
you evaluate parts of a nested formula one step at a time.

Using Nested
Functions

Create a Conditional Formula
Using a Nested Function

Click the cell where you want to
enter the function.

Click the Formulas tab.

Type = (an equal sign).

Click a button from the Function
Library with the type of function
you want to use, click a submenu
if necessary, and then click the
function you want to insert into a
formula.

For example, click the Logical &
Reference button, and then click
COUNTIF.

Excel inserts the function you
selected into the formula bar with
a set of parenthesis, and opens
the Function Arguments dialog
box.

Type a function as an argument to
create a nested function, or a
regular argument.

For example, =COUNTIF(E6:E19),
“>”&AVERAGE(E6:E19)).

Click OK.6
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Formula Result

=AND(A2>A3, A2<A4) If A2 is greater than A3 and less than A4, 
then return TRUE, otherwise return FALSE

=OR(A2>A3, A2<A4) If A2 is greater than A3 or A2 is less than A4,
then return TRUE, otherwise return FALSE

=NOT(A2+A3=24) If A2 plus A3 is not equal to 24, then 
return TRUE, otherwise return FALSE

IF(A2<>15, “OK”, If the value in cell A2 is not equal to 15, then
“Not OK”) return “OK”, otherwise return “Not OK”

1

4 2

Conditional Formula Examples
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Evaluate a Nested Formula One
Step at a Time

Select the cell with the nested
formula you want to evaluate. You
can only evaluate one cell at a
time.

Click the Formulas tab.

Click the Evaluate Formula button.

Click Evaluate to examine the
value of the underlined reference.

The result of the evaluation
appears in italics.

If the underlined part of the
formula is a reference to another
formula, click Step In to display
the other formula in the Evaluation
box.

The Step In button is not available
for a reference the second time
the reference appears in the
formula, or if the formula refers to
a cell in a separate workbook.

Continue until each part of the
formula has been evaluated, and
then click Close.

To see the evaluation again, click
Restart.

Some parts of formulas that use IF
and CHOOSE functions are not
evaluated, and #NA is displayed. If
a reference is blank, a zero value
(0) is displayed.

IMPORTANT Some functions
recalculate each time the
worksheet changes, and can
cause the Evaluate Formula to
display different results. These
functions include RAND, AREAS,
INDEX, OFFSET, CELL, INDIRECT,
ROWS, COLUMNS, NOW, TODAY,
AND RANDBETWEEN.
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Instead of using a cell to store a constant value or function for use in a
formula, you can create a name to store it and then use the name in a
formula. If you wanted to calculate sales tax, for example, you could
create a name called Sales Tax and assign it a constant value. You can
also store text in a name. Instead of typing a long name, such as
Environmental Protection Agency, you could create a name called EPA
and then use the easy-to-type three letter abbreviation in a formula.
When you use EPA in a formula as a text string, Excel replaces it with
Environmental Protection Agency. It also works for functions and
nested functions.

Using Constants and
Functions in Names

Use a Constant or Function in a
Name

Click the Formulas tab.

Click the Define Name button.

Type a name for the reference.

Click the Scope list arrow, and
then click Workbook or a specific
worksheet.

If you want, type a description of
the name.

The current selection appears in
the Refers to box.

In the Refers to box, type = (equal
sign) followed by the constant,
text, or function you want to use.

=.0875, or =”Environmental
Protection Agency”

Click OK.7
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Did You Know?
You can edit the contents of the Refers
to box in the New Names dialog box.
Since the contents of the Refer to box
is in point mode, you can not use the
insertion point and arrow keys to edit
it. Press F2 to switch to edit mode,
where you can use the insertion point
and arrow keys to edit it.

Define Name buttonConstant name used in formula
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Index

A
absolute cell references, 80

creating, 81
relative references, changing, 81

Accessibility Checker, 27
accounting format, 43
Acrobat Reader, 185
acronyms, spell-checking, 62
action items in meetings, 498
Actions, 35, 447

changing options, 60
deleting, 61
inserting information using, 61

Active controls
alerts, dealing with, 465
inserting, 464
movies, playing, 469
properties, setting, 467
security settings, 369
toolbox buttons for, 466
VBA code, adding, 468
viruses, avoiding, 362-363

Ad-aware, Lavasoft, 362
adding/removing. See also deleting

clip art, 194
data connections, 405
digital signatures, 359
passwords, 357
Quick Access Toolbar, items from, 7
Status bar, items from, 9
tab colors, 154

add-ins. See also Analysis ToolPak; COM
add-ins; Conditional Sum Wizard;
Excel add-ins; Solver

alerts, 449
loading/unloading, 325, 448-449
managing, 447

security options, 368
viewing, 446

Add-Ins tab, 4
adjacent cell contents, filling with, 45
Adobe Systems

Acrobat Reader, 185
Photoshop, 207

advanced document properties, 438
advanced options, setting, 436
adware, 362
alerts, 430. See also Groove

add-in alerts, 449
alignment

for cell styles, 167
in charts, 274
of chart text, 284
Format dialog box, changing with, 147
of objects, 252-253
Ribbon, changing with, 146
with SmartArt graphics, 220

Alignment Dialog Box Launcher
changing alignment with, 147
multiple alignment options, setting, 148

All Data Sources files, opening, 13
All Web Pages, opening, 13
Alt key, drag-and-drop with, 51
ampersands in headers and footers, 177
Analysis ToolPak, 325, 447

using, 326
Analysis ToolPak VBA, 447
animation

animated GIFs, inserting, 189
feedback with, 436
for organization charts, 228

anonymous FTP sites, 426
antivirus software, 363
Apply button, 8
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Arabic, support for, 444
area charts, 263
arguments, 72, 74

array arguments, 105
with Formula AutoComplete, 76
lookup function arguments, 335
placeholder arguments, inserting, 103

arithmetic operators, 73
array arguments, 105
arrows

changing, 235
Chart Elements list arrow, 269
Counterbalance Arrows, 218
drawing, 234
Number Format list arrow, 43
Shape Outline button for, 234-235
tracer arrows, 100
up/down arrows, 8

artistic style, 197
ascending order sorts, 306-307
asterisk (*) character, 336
as you type corrections, 59
attachments

viruses, avoiding, 362-363
workbooks as, 386
XML Schema as, 388

Auditing feature
calculation errors, correcting, 97
worksheets, auditing, 100

AutoComplete, 40-41. See also Formula
AutoComplete

enabling, 430
AutoCorrect, 35

adding entries, 59
for cell contents, 58-59
editing entries, 59
with spell-checking, 62
as you type, 59

AutoCorrect Exceptions dialog box, 58
AutoFill, 44-45

adjacent cell contents, filling with, 45
complex series, creating, 44
custom fill, creating, 45
formulas, copying, 78
List AutoFill, 305
repeating data, entering, 44
suppressing, 45
tables, entering data into, 305

AutoFill Options button, 44
AutoFilter

grouping dates in, 434
slicer, 316-317
PivotChart, 319
PivotTable, 314-317
table parts, displaying, 308

AutoFit for columns and rows, 120-121
Autoimport dialog box, 260
automated safe mode, 376-377
automatic calculations, 91
automatic page breaks, 178
AutoPublish, 420
AutoRecover, 31
AutoShapes, 258
AutoSum, 92-93

extended AutoSum, 93
subtotals, calculating, 92-93

average, formatting cell contents based on,
136-137

AVERAGE functions, 71, 72, 102
automatic calculations, 91
AutoSum calculations, 92-93
subtotals, calculation of, 337
3-D cell references with, 83

AVERAGEIF function, 338-339
axes. See chart axes

B
backgrounds

adding/removing, 154
cell backgrounds, colors for, 150
chart backgrounds, changing, 286
for pictures, 207
removing background picture, 210
as shape fills, 240
themes, background colors in, 156
worksheet backgrounds, changing, 112

backup files, opening, 13
bar charts, 263

formatting, 285
beveling

to charts, 275
for data series, 283
precedence of, 246
to shapes, 247, 248-249
to SmartArt graphics, 225



Index 531

to WordArt text, 214
BIFF12 file format, 24-25
bitmap images

modifying, 207
resizing, 203

black and white pictures, converting, 206
boldfacing

comments, 383
text, 134-135

borders
cells, adding to, 152-153
for cell styles, 167
in charts, 274
for data series, 283
drawing borders, 152-153
with Format Cells dialog box, 153
pictures, applying to, 200
Ribbon, adding or deleting with, 152

bottom-alignment of objects, 253
brightness, 205

Picture Manager, editing in, 443
bright room effects to shapes, 248-249
Bring to Forward

objects, 255-256
with SmartArt graphics, 220

buttons, 8

C
Calculation Options button, 72
calculations. See also functions

automatic calculations, 91
with AutoSum, 92-93
circular references, locating, 101
errors, correcting, 97
iterative calculation, enabling, 437
keyboard commands for, 79
links in, 402
multiple results, calculating, 105
one time calculations, performing, 94-95
options, setting, 437
performing, 72
Status bar, displaying with, 91
in tables, 301

capital letters. See case sensitivity
Caps Lock, 9
case sensitivity

AutoCorrect Exceptions dialog box for

case, 58
table data, sorting, 306
text functions, 336

categories for clip art, 192
cell address, 35
cell notes. See comments
cell references, 80

circular references, locating, 101
examples, 72

cells, 35. See also alignment; cell refer-
ences; charts; comments; labels;
named ranges

applying names to, 86-87
average, formatting cell contents based

on, 136-137
borders, adding, 152-153
clearing cells, 47, 55
colors, adding, 150
conditional formatting, 136-137
copying

contents, 50-51
formats, 155

correcting contents of, 58-59
cutting contents of, 52
deleting, 54-55

cell styles, 168-169
name ranges, 89
from Watch window, 98
worksheet, cells in, 54-55

drag-and-drop
copying contents with, 50-51
enabling, 430

editing, 46, 430
cell styles, 168-169
names of cells, 89

filling backgrounds with colors, 150
finding and replacing, 56-57
formulas in, 74-75, 435
inserting blank cells, 54
locking/unlocking, 354
managing names, 88-89
moving cell contents, 52-53
names, 84-85

changing, 89
entering, 86-87
managing, 88-89

organizing names, 88-89
orientation of cell contents, 146-147
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cells (continued)
page breaks in, 178
pasting cell data, 48
patterns, applying, 150
pointing to, 75
ranking, formatting cell contents based 
on, 136-137
searching for values, 123
selecting, 37
storing contents of, 49
viewing names, 88-89
Watch window, using, 98
wrapping text in, 74
zero value cells, 435

cell styles, 131
applying, 166
custom styles, creating, 167
deleting, 168-169
editing, 168-169
for hyperlinks, 416
merging, 168-169

Cell Styles gallery, 167
centering objects, 253
certification authority (CA), 358
chart area, 269
chart axes, 262, 276-277

changing, 277
editing, 267
titles, changing, 279

chart floor, 286
charts, 261. See also data series; legends;

pie charts; PivotChart
background, changing, 286
creating and inserting, 264
data labels, 280-281
data source, editing, 287-288
data tables, showing/hiding, 280-281
default charts, creating, 265
deleting objects, 270
editing, 266-267

chart data, 288-289
text, 265

elements
formatting, 274-275
names, showing, 433
selecting, 269

embedded charts, 264
empty cells, displaying, 289

enhancing charts, 287
enlarging chart objects, 269
error bars, 285
formatting

bar charts, 285
elements, 274-275
line charts, 285
text, 284

gridlines, changing, 276
hidden data, displaying, 289
labels, 280-281
layout, applying, 272
moving, 268
options, 432
other worksheets, moving to, 265
pictures, inserting, 287
resizing, 268
shapes, inserting, 275, 287
styles, 272-273

shape styles, applying, 275
templates

applying, 293
creating, 292
managing, 294

terminology, use of, 262
text

adding, 287
editing, 265
formatting, 284

text boxes in, 287
3-D effects in, 274, 286
titles, 262

axes titles, changing, 279
changing, 278-279

types of, 263, 270-271
Charts Dialog Box Launcher, 264
Chart Type dialog box, 293-294
chart wall, 286
check boxes, 8

for Active controls, 466
Check for Updates button, 33
Check Office Documents that are from or

link to suspicious Web sites option,
363, 372

Chinese, support for, 444
circles, drawing, 230
circular references, locating, 101
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class modules in VBA (Visual Basic for
Applications), 451

clearing
cells, 47, 55
conditional formatting, 141
data tables, 297
print area, 182
validation circles, 322

Clear Rules commands, 141
clear surfaces for shapes, 248-249
clip art, 187

adding/removing clips, 194
categories, organizing into, 192
downloading clips, 191
locating and inserting, 188
media clips, 189
objects, 188
properties, changing, 193
searching, 187, 188

Web for clips, 191
Web, accessing on, 190-191

Clip Art task pane, 188
properties of clip, changing, 193
working with, 192-193

Clipboard
cell contents, storing, 49
formulas, copying, 78-79
multiple items, cutting, 52
objects, copying and moving, 237
pasting data with, 48

Clipboard Dialog Box Launcher, 49, 237
Clip Organizer, 188

adding/removing clips with, 194
motion clips, playing, 189
properties of clip, changing, 193
shapes, adding, 260
sound clips, playing, 189
working with, 192-193

closing workbooks, 34
code for VBA, 450
Collapse Dialog button, 85

chart data, editing, 288-289
for data validation, 322

colors. See also fonts; pictures; shapes;
themes

for borders, 152-153
cells, adding to, 150
custom colors, adding, 151

formatting with color scales, 138-139
hyperlink colors, 156
for menus, 151
in organization charts, 228
Picture Manager, editing in, 443
properties of, 159
schemes, selecting, 428
SmartArt graphics, changing for, 223
tabs, adding or removing colors to, 154
WordArt fill colors, changing, 212-213
of worksheet tab names, 115

Column Differences option, 38
columns and rows. See also tables

data series, plotting, 288
default column width, changing, 120
deleting, 119
display options, 435
freezing/unfreezing, 122
height of rows, adjusting, 120-121
hiding/unhiding, 117
inserting, 118
multiple columns and rows

deleting, 119
inserting, 118
selecting, 116

pasting cells from, 53
printing

options, 180-181
print area for, 182

selecting, 116
showing/hiding, 117
text to columns, converting, 321
Use row and column names option, 87
width of columns, adjusting, 120-121

COM add-ins, 447
loading/unloading, 448-449

combo boxes for Active controls, 466
COM (Component Object Model). See

Active controls; COM add-ins
comma delimiter, 321
command buttons, 4

for Active controls, 466
commands

from Office menu, 5
Quick Access Toolbar, adding to, 441
from Shortcut menu, 5

Comma Style button, 132
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comments
adding comments, 382
clearing, 47
deleting, 383
display options, 433
editing, 383
reading comments, 382

comparison
formatting cell contents for, 136
operators, 73

compatibility, 14, 24
of functions, 347
of workbooks, 26

complex series, creating, 44
compressing pictures, 204

in Picture Manager, 443
Compression Settings dialog box, 204
conditional formatting, 136-137

clearing, 141
with color scales, 138-139
with data bars, 138
editing rule precedence, 142
finding cells with, 143
with icon sets, 138-139
rules, creating, 140
specialized conditional formatting,

applying, 138-139
Conditional Formatting Rules Manager, 142
conditional formulas

examples of, 106
with nested functions, 106

connecting objects, 254
Connection Properties dialog, 404-405
Connection Status, checking, 21
consolidating data, 400-401
constants

defined, 72
in names, 108

contextual spelling, checking, 63
contextual tabs, 4
contiguous cells, 35, 37
contours

for data series, 283
for shapes, 248-249

contrast, 205
Picture Manager, editing in, 443

Convert to Columns Wizard, 321
Copy command for worksheets, 112

copying. See also Clipboard; pasting
clip art, 193
dialog box, files in, 13
hyperlinks, 416
macro modules, 459
objects, 237
Web tables to worksheet, 421
window contents, 198
worksheets, 112-113

correcting. See also AutoCorrect; errors
cell contents, 58-59

Counterbalance Arrows, 218
COUNT functions, 102

automatic calculations, 91
AutoSum calculations, 92-93
3-D cell references with, 83

COUNTIF function, 338-339
Create a copy check box, 112
cropping. See pictures
CSS, Web pages allowing, 417
CSV format, 25
Ctrl key, 237
currencies

Euro Conversion Wizard, 327
Euro Currency Tools, 447
format for, 43
formatting numbers in, 133

Currency Style button, 132
curved connectors, 254
customizing, 427. See also fills; page layout;

themes
advanced properties, 438
cell styles, 167
colors, 151
dictionaries, 64-65
margin settings, 175
Quick Access Toolbar, 7
shadows, 251
shapes, creation of, 440
templates, 130
text objects, creation of, 440
themes, colors for, 159
workbook views, 126

cut, copy, paste options, 431
cutting cell contents, 52
Cyrillic, keyboard configuration for, 444
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D
DAISY (digital Accessible Information

System), 27 
dark edges for shapes, 248-249
dark variations for pictures, 206
data. See also alignment; external data

labels, 280-281
for PivotTable, 319
simplifying entry, 43
validation, 322

Data Analysis dialog box, 326
data bars, 138
data connections, security settings for, 374
Data Connection Wizard, 403
data maps. See XML (Extensible Markup

Language)
data markers

for charts, 262
editing, 266

data series, 262, 264
adding, 290
changing, 291
deleting, 290
editing, 288
formatting, 283
order, changing, 291
plotting, 288
type of chart, changing, 271

Data tab, 4
Data Validation dialog box, 323
dates and times

formats for, 43
functions, 104, 340-341
long date format, 43
short date format, 43
worksheets, entering on, 42

dBASE, 403
opening files, 13

DDE (Dynamic Data Exchange), 436
debugging macros, 458
Debug toolbar, 458
decimals, automatic insertion of, 430
Decrease Decimal button, 132
defined names, 84
Delete Cropped Areas Of Picture options,

204

deleting. See also cells; Groove; pictures;
ranges; shapes; tables; themes

borders, 152-153
chart objects, 270
clip art, 194
columns and rows, 119
comments, 383
data series, 290
dialog box, files in, 13
digital signatures, 359
file encryption, 355
font attributes, 133
macros, 457
name ranges, 89
numeric formats, 133
page breaks, 179
passwords, 357
PivotChart, 318
PivotTable, 310
Quick Access Toolbar, items from, 7
SmartArt graphics, shapes from, 219
Status bar, items from, 9
text boxes, 233
Text pane, deleting line in, 219
themes, custom colors in, 159
values, keeping formulas, 96
vertex on freeform, 236
Watch window, cells from, 98
WordArt text, 211
workbooks, custom views in, 126
worksheets, 111

delimiters, 321
dependent cells, 80
depth

for data series, 283
shapes, adding to, 248-249

descending order sorts, 306-307
designation files, 394
detailed data, 337
Developer tab. See Ribbon
diagnosing problems. See repairing prob-

lems
dialog boxes. See also specific types

navigating, 8
options, choosing, 8

Dialog Box Launchers, 3, 8
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dictionaries
custom dictionaries, 64-65
for foreign languages, 444
Research task pane for accessing, 68

DIF format, 25
opening files, 13

digital cameras, inserting pictures from, 195
digital signatures

adding/removing, 359
on macros, 460
for workbooks, 358-359
XPS support for, 186

direction
for gradient fills to shape, 245
moving, 430
of WordArt text, 215

Disabled Items dialog box, 447
display view options, setting, 433
distributing objects, 252
Document Information Panel, 28

Mark as Final command, 378
template, selecting, 470

Document Inspector, 350-351
Document Management Servers

Saving to SharePoint Server, 498
Opening from SharePoint Server, 499

documents
advanced properties, changing, 438
digital signatures, adding, 359
Document Management task pane 
inspecting, 350-351
visible signature line, adding, 360-361

documents (Word)
Office Web App, creating, 485

Document Themes folder, 163-164
deleting custom themes from, 164

Download.com, 363
downloading

clip art, 191
privacy options, setting, 372
Publish as PDF or XPS add-in, 185
viruses, avoiding, 362-363
Web updates, 33
workbook templates, 11

drag-and-drop. See also cells
to different worksheets, 51
moving cell contents, 52

in Text pane, 217
drawing

borders, 152-153
freeforms, 236
shapes, 230
ungrouping/regrouping drawings, 259

Drawing tab, 4
drop-down lists

creating, 323
tables, entering data into, 305

Duplicate command, 237
duplicate words

checking for, 62
flagging, 63

E
Edit Data Source dialog box, 288-289
editing. See also cells; charts

AutoCorrect entries, 59
clip art keywords, 193
comments, 383
conditional formatting rule precedence,

142
embedded objects, 398
of final workbook, 378
formulas, 78-79
freeforms, 236
hyperlinks, 414
macros, 459
options, setting, 430
in Picture Manager, 443
range names, 89
read-only workbook, 378
Refers to box contents, 108
SmartArt graphics, shapes in, 221
templates, 130
WordArt text, 211

Edit Points command, 236
eFax, 387
effects. See also 3-D effects

for organization charts, 228
picture effects, applying, 201
to shapes, 246-247
to SmartArt graphics, 225
theme effects, creating, 162
to WordArt text, 214

elbow connectors, 254
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elements. See also charts
header or footer, inserting into, 177
security for, 352
table elements, formatting, 300
workbook elements, showing/hiding, 124
XML elements, 390

e-mail. See also attachments
hyperlinks to address, 414
spam, 362
viruses, avoiding, 362-363

embedding, 394
in charts, 264
editing embedded objects, 398
existing object, embedding, 398-399
new object, embedding, 398-399

Enable background error checking check
box, 99

encryption to workbooks, adding, 355
entering cell contents, 148
error bars, 285
Error checker

circular references, locating, 101
formula errors, correcting, 98-99

errors
add-in user interface errors, showing,

436
calculation errors, correcting, 97
formulas, correcting errors in, 98-99

Esc key, 155
Euro Currency Tools, 447

Euro Conversion Wizard, 327
European languages, support for, 444
Evaluate Formula dialog box, 106-107
event procedures in VBA (Visual Basic for

Applications), 451
Excel add-ins, 325, 447

loading/unloading, 448
Excel Options dialog box, 434-435

Web updates from, 33
Excel window, viewing, 3
exclusion dictionaries, 64-65
existing workbooks. See workbooks
Expand dialog button, 85
Expansion Pack button, 391
exploding pie slice, 282
exporting. See importing and exporting
expressions, defined, 72
extended AutoSum, 93

external content security options, 374-375
external data

changing connection properties, 405
connections, managing, 403-404
existing connection, connecting with,

404
from Microsoft Access, 408-409
new data source, defining, 406
refreshing data from, 405
security for, 403
sources, 403

F
faxing workbooks, 387
feedback options, 436
file block settings, 364, 367
file encryption, adding, 355
file extensions, displaying, 14
file formats

list of, 25
workbook file formats, 24-25

file sharing. See sharing
File tab, 3, 5

recently opened files in, 13
FileZ, 363
fill handles

with AutoFill, 44
enabling, 430

fills. See also gradient fills; shape fills
for cell styles, 167
in charts, 274-275
customizing, 45

gradient fills, 245
for data series, 283
picture fills, 242
shapes, adding to, 240-241
for SmartArt graphics, 224
textures, 243
WordArt text, applying to, 212-213

filtering, slicer, 316-317
filtering cell names, 88
Financial functions, 104, 343
Find & Select button, 143
finding and replacing, 35. See also

searching
cell contents, 47, 56-57
formatting, finding and replacing, 170
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Flash movies with Active controls, 469
flat surfaces for shapes, 248-249
flipping

in Picture Manager, 443
shapes, 257

flow of text, controlling, 148
folders

Document Themes folder, 163-164
Font Color button, 149
fonts. See also cell styles; themes

changing font size, 134-135
for chart text, 284
colors, 134-135, 149
for comments, 383
deleting attributes, 133

footers. See headers and footers
foreign languages

adding to Office programs, 444
thesauruses, 67
translating text to, 69

Format Cells dialog box, 43
alignment options, 147
borders, applying, 153
numbers, formatting, 133
text, formatting, 134-135

Format Painter
applying styles with, 155
with tables, 298

Format Shape dialog box, 246
for picture effects, 201
shadow options, 251
undoing changes in, 240, 242
WordArt text with, 215

formatting. See also charts; conditional for-
matting; SmartArt graphics; tables

average, formatting cell contents based
on, 136-137

comparison, formatting cell contents for,
136

copying cell formats, 155
finding and replacing, 170
hyperlinks, 416
numeric formats, 132-133
PivotTable reports, 313
ranking, formatting cell contents based

on, 136-137
sparkline, 144-145

text, 134-135
in Text pane, 219
values, 43
WordArt text, 212-213

forms. See Groove
Formula AutoComplete, 76-77

keyboard navigation, 77
named cell or range, entering, 86
setting, 437
turning on/off, 77

formula bar, 433
cell contents, editing, 46
editing formulas with, 78
resizing, 74-75, 84

formulas, 36, 37, 71. See also calculations;
cell references; nested functions

array formulas, creating, 105
AutoFill, copying with, 78
in cells, 74-75, 435
Clipboard, copying with, 78-79
columns and rows, rechecking on delet-

ing, 119
definitions, 72
deleting values, keeping formulas, 96
displaying in cells, 74-75
editing, 78-79
error displays, avoiding, 97
errors, correcting, 98-99
with Formula AutoComplete, 76-77
Goal Seek, 329
links in, 402
multiple results, calculating, 105
one time calculations with, 94-95
options, setting, 437
order of precedence, 72, 74
ranges, using, 90
showing/hiding, 354
simple formula, creating, 74-75
table names in, 437
value, converting formula to, 85
Watch window, using, 98

Formulas tab, 4
fraction format, 43
freeforms, 229

drawing, 236
editing, 236
vertices of, 236
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freezing/unfreezing columns and rows, 122
FTP (File Transfer Protocol)

accessing sites, 426
adding or modifying locations, 426

Full Screen view, 29
Function Library, 104
function procedures in VBA (Visual Basic for

Applications), 451
functions, 71. See also nested functions

commonly used functions, 102
creating, 103
defined, 72, 102
entering, 102
with Function Library, 104
Insert Function button, entering with, 103
in names, 108
ScreenTips for, 433
summarize data functions, 338-339
text functions, 336

Function Wizard button, 103

G
general options, setting, 428
GetPivotData functions, 437
GIF format, 207

animated GIFs, inserting, 189
glow, applying

to charts, 275
to organization charts, 228
to pictures, 201
to shapes, 247
to SmartArt graphics, 225
to WordArt text, 214

Goal Seek, 329
Go To Special dialog box

cells, locating, 38
formulas to values, converting, 96

gradient fills
custom gradient fills, 245
shapes, applying to, 244-245
WordArt, applying to, 212-213

grand totals, 337
graphics, 187. See also clip art; pictures;

SmartArt graphics; WordArt
formats, adding, 195
for hyperlinks, 416

grayscale mode for pictures, 206
Greek, keyboard configuration for, 444
gridlines

chart gridlines, changing, 276
in charts, 262
display options, 435
printing, 181

Groove, 494-497
alerts, 496
creating workspace, 494-495
deleting

workspace, 494
inviting users to, 497
launching, 494
Microsoft SharePoint Workspaces, 

494-497
permissions, changing, 497
roles in, 497
sharing files in, 496
starting, 494
tools, Documents, managing, 496

grouping/ungrouping
creating groups, 320
outline data, 320
shapes, 258-259
with SmartArt graphics, 220
tables, 258
worksheets, 112

Guest role in Groove, 497

H
hackers. See security
handles. See also fill handles

for charts, 262
on shapes, 230

hardware graphics acceleration, 433
harmful attacks, avoiding, 362-363
headers and footers, 171

elements in header or footer, inserting,
177

inspecting information in, 351
options for, 177
predefined header or footer, adding, 176
in tables, 300
watermarks in, 177

Hebrew, support for, 444
height of rows, adjusting, 120-121
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help
exclusion dictionaries, finding, 65
with Help Viewer, 20, 21
Microsoft, contacting, 33
searching for, 21

Help Viewer, 20
Connection Status, checking, 21

hiding. See showing/hiding
high-low lines, 285
HLOOKUP function, using, 334-335
Home tab, 4
homographs, 362
horizontal alignment, 146-147

of WordArt text, 215
horizontal page breaks, 178
HSL color mode, 151

in themes, 159
HTML (Hypertext Markup Language), 25,

411. See also Web pages
hue of color, defined, 159
hyperlinks, 395, 411

colors, 156
creating, 414
editing, 414
formatting, 416
jumping to, 415
removing, 415

I
icon sets, formatting with, 138-139
Image button for Active controls, 466
image options, 432
importing and exporting, 394

Access database into workbook, export-
ing, 408

copy and past for exporting, 396
other program format, exporting files to,

397
in Picture Manager, 442
SharePoint lists, exporting tables to, 324
text files, 397, 410
Web queries, data from, 423-424
XML data, 391-392

Import Text Wizard, 410
Increase Decimal button, 132
indenting text in Text pane, 219
InfoPath Form Template files, 470

Information functions, 346
Insert Function dialog box, 72, 103
Insert tab, 4
Inside borders, 153
inspecting documents, 350-351
IntelliMouse, 16
InterFAX, 387
Internet. See also queries; Web pages

clip art, accessing, 190-191
fax, sending workbooks by, 387
FTP (File Transfer Protocol) documents,

426
Web updates, 33

Internet Assistant VBA, 447
Internet Options dialog box, 412
invisible content, inspecting, 351
italicizing

comments, 383
text, 134-135

J
Japanese

support for, 444
JPG/JPEG format

pictures, modifying, 207

K
keyboard

for foreign languages, 444
Formula AutoComplete, navigation of, 77
formulas, commands for recalculating,

79
workbooks, navigating in, 17

KeyTips, 4
keywords for clip art, 193

L
labels

for Active controls, 466
with AutoComplete, 40-41
chart labels, changing, 280-281
consolidating data including, 400
data labels, 280-281
entering, 36, 40-41
long labels, truncating, 41
number as label, entering, 40
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relative cell names, 89
text labels, entering, 40

landscape orientation, 172
LANs (local area networks), 470
Lavasoft's Ad-aware, 362
layouts. See also page layout

chart layouts, applying, 272
for organization charts, 228
PivotTable reports, 313
for SmartArt graphics, 223

left-alignment of objects, 253
legends, 262

changing, 280
editing, 267

LEN function, 336
light and dark variations for pictures, 206
lighting effects for shapes, 248-249
line charts, formatting, 285
lines, 229

changing, 234
drawing, 234
Quick Styles, adding, 234

links and linking, 394-395. See also hyper-
links

charts to worksheets, 278
creating links, 398
existing object, linking to, 398-399
security settings for workbooks, 374-375
updating links, 399, 436
worksheets or workbooks, creating links

between, 402
List AutoFill, 305
list boxes, 8

for Active controls, 466
Lists and Galleries, 3
live preview, 4

enabling, 428
for picture effects, 201
for recolored pictures, 206
for SmartArt graphics, 216
WordArt text effects, 214

Lock Drawing Mode, 232
locking/unlocking cells, 354
Logical functions, 104, 342
logical operators/conditions

data validation and, 322

tables, searching, 309
long date format, 43
Lookup function, 104

HLOOKUP function, using, 334-335
VLOOKUP function, using, 334

LOWER function, 336
luminosity of color, defined, 159

M
macros. See also workbooks

controlling, 458-459
copying macro modules, 459
creating, 456
debugging, 458
deleting, 457
digital signatures, adding, 460
editing, 459
opening, 13
Personal Macro Workbook option, 454,

455
recording, 455
running, 457
security of, 352, 370
self-signing certificates for, 460
Status bar, checking with, 9
stopping macros, 457
toolbar, assigning to, 461
Trust Center

opening workbooks with, 463
security options, setting, 370

understanding, 454
viruses, avoiding, 362-363
writing, 370

maintenance, performing, 32
Manager role in Groove, 497
Manage Templates button, 294
many to many pasting of data, 48
many to one pasting of data, 48
margins

customizing settings, 175
mouse, changing with, 174-175
settings, changing, 174-175

Mark as Final command, 378
marquees for copying cell contents, 50
Math & Trig functions, 104, 344
matte surfaces to shapes, 248-249
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MAX functions
automatic calculations, 91
AutoSum calculations, 92-93
3-D cell references with, 83

maximizing/minimizing
Ribbon, 4, 6
windows, 18

McAfee antivirus software, 363
media clips, 189
menus. See also specific types

colors, adding, 151
merging cells, 148

styles, 168-169
Message Bar

macro problems, notification of, 460
security options, changing, 371

metadata, 350-351
metal surfaces to shapes, 248-249
MHT/MHTML formats, 25
Microsoft Access, 403

exporting table into workbook, 408
opening database files, 13
PivotTable from Access database, creat-

ing, 408-409
Microsoft DirectShow, 189
Microsoft FoxPro, 403
Microsoft Office. See also Groove

harmful attacks, avoiding, 362-363
for help, 33
maintenance, performing, 32
safe modes, 376-377

Microsoft Office Picture, 427
Microsoft Organization Chart, 227
Microsoft Paint, 207
Microsoft Picture Manager. See Picture

Manager
Microsoft PowerPoint

organization charts with, 227
SmartArt graphics in, 187

Microsoft SharePoint Workspaces. See
SharePoint

Microsoft SQL Server OLAP services, 403
Microsoft Templates. See templates
Microsoft Windows

harmful attacks, avoiding, 363
Media Player, 189

middle-alignment of objects, 253
MIN functions

automatic calculations, 91
AutoSum calculations, 92-93
3-D cell references with, 83

minimizing. See maximizing/minimizing
Mini-Toolbar, 5

options, setting, 428
text formatting buttons, 134

mixed cell references, 80
creating, 82

modules in VBA (Visual Basic for
Applications), 451

Modules window, 451-452
More controls for Active, 466
motion clips, 189
mouse

columns and rows, adjusting width and
height of, 120-121

resizing windows with, 18
workbooks, navigating in, 16

Move command, 112
movies, Active controls for, 469
moving

cell contents, 52-53
charts, 268
clip art, 193
dialog box, files in, 13
direction, 430
hyperlinks, 416
objects, 237
page breaks, 179
Quick Access Toolbar, 6-7
Text pane, 218
worksheets, 112

multiple columns and rows. See columns
and rows

MyFAX, 387
My Templates, 292

N
Name box, 86
named ranges, 71, 84-85

changing, 89
deleting, 89
entering, 86-87
formulas, using in, 90
managing, 88-89
organizing names, 88-89
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Name Manager, 88-89
filter options, 88

names. See also cells; named ranges;
renaming

constants in names, using, 108
functions in names, using, 108
workbooks, default names for, 10
for worksheets, 110

navigating. See also Groove
dialog boxes, 8
Formula AutoComplete, 77
in workbooks, 16-17

nested functions
conditional formulas with, 106
defined, 72
evaluating nested formulas, 107

New Formatting Rule dialog box, 140
New Name dialog box

cells, naming, 84-85
ranges, naming, 84-85
Refers to box contents, editing, 108

New Workbook dialog box, 11
new workbooks, creating, 10-11
1924 date system, 436
noncontiguous cells, 35, 37
Normal view, 29
notebook (OneNote)

Office Web App, creating, 485
Number Format list arrow, 43
numeric formats, 43, 132-133. See also cell

styles
charts, changing formats on, 274
deleting attributes, 133
separators, using, 430

numeric keypad, 42
Num Lock, 42

Status bar, checking with, 9

O
Object Browser, 451-452
objects, 229. See also shapes

alignment of, 252-253
connecting, 254
copying, 237
distributing, 252
flipping, 257
hidden objects, viewing, 256

moving, 237
rotating, 257
Selection pane, selecting with, 255
stacking order, changing, 256

ODBC (Open Database Connectivity), 403
Office.com

clip art, inserting, 188
options, 436
SmartArt graphics, 216

Office Clipboard. See Clipboard
Office Data Connection (ODC) files, 404
Office Groove. See Groove
Office Mobile, 500
Office Web Apps

accessing documents, 480-481
browser support, 472-473
collaborating, documents with, 492-493
compare to desktop app, 478-479
creating documents, 485
downloading files, 490
file compatibility, 472
introduction, 471-472
Microsoft Silverlight, 472, 474-475
Office Mobile, 500
opening documents, 481
preparing to use, 472
saving documents, 476-477
saving files, new name, 490-491
using, 472
Windows Live ID, 471-472, 474-475

sign-in, 475
OLE (object linking and embedding), 394-

395. See also Active controls
one-input data table, creating, 328
one time calculations, performing, 94-95
one to many pasting of data, 48
one to one pasting of data, 48
Open and Repair workbooks, 12
Open as Copy workbooks, 12
Open dialog box

default file location, changing, 13
file formats, opening, 13

Open in Browser workbooks, 12
opening. See also workbooks

Autoimport dialog box, 260
file formats, 13
Picture Manager, 442
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opening (continued)
templates, 129
Web page, workbook as, 412
workspace files, 127
XML files, 13, 393

Open or Save As dialog box, 28
operators

defined, 72
order of precedence, 72, 74
types of, 73

Option button, 8
for Active controls, 466

Oracle, 403
order of precedence, 72, 74
organization charts

colors in, 228
creating, 227
dotted lines in, 228
layouts, changing, 228
Quick Styles, applying, 228
shapes, adding, 227

orientation
of cell contents, 146-147
page orientation, changing, 172
SmartArt graphics, changing for, 222

outlines. See also shape outlines
on borders, 153
clearing, 320
creating, 320
SmartArt graphics, shape outlines for,

224
ungrouping data, 320
to WordArt text, 212-213

Oval button, 230

P
Page Break Preview view, 29
page breaks, 178-179

deleting, 179
moving, 179
previewing, 179

page layout, 171. See also themes
customizing

margin settings, 175
size of page, 173

headers and footers, adding, 176-177
margins, adjusting, 174-175

orientation of page, changing, 172
page breaks, 178-179
print scaling, changing, 172-173
size of page, changing, 173

Page Layout tab, 4
Page Layout view, 171

switching to, 29
Page Number Status bar, 9
Page Setup dialog box. See also page lay-

out
print scaling, setting up, 172

painting cell formatting, 155
Paint Shop Pro, 207
panes. See also window panes

task panes, 15
paper sizes, scaling for, 436
Paradox, 403
parental controls, setting, 373, 439
Participant role in Groove, 497
passwords, 349

changing, 357
deleting, 357
for FTP sites, 426
opening workbooks with, 357
range passwords, 353
strong passwords, using, 356
for workbooks, 356-357
for worksheets, 352-353

Paste Options button, 422
Paste Special

calculations, performing, 94-95
formulas, copying, 79

pasting, 48. See also copying
columns to rows, cells from, 53
formula data, 79
rows to columns, cells from, 53
with special results, 50-51
Web table data, 421

Past Special button, 50-51
patterns for cells, 150
PDF format, 1, 25. See also workbooks
percentage format, 43

enabling, 430
Percent Style button, 132
permissions

Groove workspace permissions, chang-
ing, 497

Status bar, checking with, 9
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Personal Macro Workbook option, 454, 455
phishing, 362
Picture Border button, 200
Picture Corrections options, 205
Picture Effects gallery, 201
Picture Manager

discarding changes, 443
editing in, 443
locating pictures in, 442
opening, 442

Picture Quick Style gallery, 198
pictures. See also brightness; contrast;

Picture Manager; shapes
artistic style, 197
backgrounds for, 207

removing, 210
borders, applying, 200
brightness, 205
changing, 195
in charts, 287
color modes for, 206
compressing, 204, 443
contrast, 205
correcting, 205
cropping, 208-209

with aspect ratio, 208
deleting cropped areas of pictures,

204
with fill or fit, 209
Picture Manager, editing in, 443
precisely cropping, 208-209

deleting
borders, 200
cropped areas of pictures, 204

effects, applying, 201
files, inserting pictures from, 195
fills to shapes, applying, 242
original state, resetting to, 207
precisely resizing, 202
Quick Styles, adding, 198
recoloring, 206-207
redisplaying cropped pictures, 208
removing background, 210
resizing, 202-203
rotating, 208-209

with Picture Manager, 443
3-D rotation, 201

soften, 205

scaling pictures, 202-203
screen shot, inserting, 196
sharpen, 205
transparent background, setting, 207
WordArt, applying to, 212-213

Picture Shape gallery, 199
Picture SmartArt, 226
Picture Tools tab, 4
pie charts, 263

exploding pie slice, 282
Pin icon for workbooks, 12
PivotChart, 264

Access database, creating from, 408-409
analyzing data with, 310
modifying reports, 319
refreshing data in, 319
renaming, 318
summarizing data in, 318
updating, 311

PivotChart Filter Pane, 318
PivotTable

Access database, creating from, 408-409
analyzing data with, 310
AutoFilter, 314-315
calculation, 314-315
conditional formatting rules, clearing,

141
creating reports, 310
data source for, 319
field settings, changing, 312
formatting reports, 313
GetPivotData functions, 437
modifying reports, 312
Quick Styles, 313
refreshing data in, 319
renaming, 318
repeating labels, 314-315
scenarios, reports from, 331
searching, 315
security for reports, 352
showing values, 314-315
slicer, 316-317
sorting, 315
updating, 311

placeholders
arguments, inserting, 103
SmartArt graphic, text in, 217

plastic surfaces for shapes, 248-249
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Playback Status bar, 9
plot area, 269

background for, 286
PMT function, 102
PNG format

pictures, modifying, 207
shapes as pictures, saving, 198
Web pages allowing, 417

points, 120, 135
polygons. See freeforms; shapes
Pop-up Blocker, 362
portrait orientation, 172
precedence order, 72, 74
presentation (PowerPoint)

Office Web App, creating, 485
presets. See also 3-D effects

to charts, 275
gradient fills as, 244
shapes, adding to, 244, 246
to SmartArt graphics, 225

preview buttons, 8
previewing. See also live preview

page breaks, 179
Web pages, 413
worksheets, 171, 183

Print dialog box, 183
printer fonts, 135
printing, 171. See also columns and rows

all of worksheet, 184
comments, 172
formulas, 75
gridlines, 181
letters of columns, 181
numbers of rows, 181
part of worksheet, 180, 184
print area, setting, 182
scaling, changing, 172-173
specific number of pages, fitting work-

sheet on, 181
tables, 298
titles for columns and rows, 180

Print Preview, 4, 183
Privacy Options. SeeTrust Center
procedures in VBA (Visual Basic for

Applications), 451
Product function, 83
program tabs, 4
Project Explorer, 451-452

projects in VBA (Visual Basic for
Applications), 451

proofing options, changing, 63
PROPER function, 336
proportional shapes, drawing, 230
proprietary company information, 

accessing, 68
Protected view, 364, 366-367
protection. See security
Protect Workbook button, 352
Publish as PDF or XPS add-in, 185, 186
publishing, 411. See also Web pages

Publish as PDF or XPS add-in, 185, 186
trusted publishers, 365

Q
queries

creating database query, 407
data from Web queries, importing, 423-

424
importing, 423-424
new data source, defining, 406
opening query files, 13
refreshable Web queries, creating, 422
saving Web queries, 424

Query Wizard, 403, 406-407
question mark (?) character, 336
Quick Access Toolbar, 3, 5

commands, adding, 441
customizing, 7
macros, assigning, 461
Quick Print button, 184
resetting, 441

Quick Print button, 184
Quick Styles. See also Shape Quick Style

to lines, 234
for organization charts, 228
for pictures, 198
to shapes, 238
for SmartArt graphics, 222
to tables, 298

quitting Excel, 34

R
range references, 37
ranges, 37. See also calculations; named

ranges



Index 547

applying names to, 86-87
extending formats, 430
formulas, using in, 90
managing names, 88-89
multisheet ranges, selecting, 39
passwords for, 353
special ranges, selecting, 39
tables, converting, 302-303
viewing names, 88-89
zooming on name range, 88

ranking, formatting cell contents based on,
136-137

read-only workbooks, 12
marking as, 378
prompt to, 380 

recent documents, 433
file extensions, displaying, 14

recoloring pictures, 206-207
Recolor Picture Quick Style gallery, 206
recording macros, 455
recovering workbooks, 30-31
Rectangle button, 230
red eye removal, 443
redoing actions, 70
Reference function, 104, 334-335
reference operators, 73
reflections

to charts, 275
to pictures, 201
to shapes, 247
to SmartArt graphics, 225
to WordArt text, 214

refreshing
external data source, data from, 405
PivotChart/PivotTable data, 319
Web queries, 422

relative cell references, 80
absolute references, changing, 81
labeling names, 89

removing. See adding/removing; deleting
renaming

dialog box, files in, 13
PivotChart or PivotChart, 318
worksheets, 110

repairing problems
macros, debugging, 458
Microsoft Office problems, 32
workbook problems, 32

repeating data, entering, 44
REPLACE function, 336
replacing. See finding and replacing
research

changing options, 439
parental controls, setting, 373, 439
topics, researching, 68

Research task pane
researching topics with, 68
translating text with, 69

Reset Picture button, 199
resizing

cell names, accommodating, 88
charts, 268
formula bar, 74-75, 84
page size, 173
in Picture Manager, 443
shapes, 230-231
SmartArt graphics, 221
tables, 302-303
task panes, 15
Text pane, 218
vector images, 188
watermark picture, 177
window panes, 15
windows, 18

Review tab, 4
RGB color mode, 151

defined, 159
in themes, 159

Ribbon, 1, 3. See also tabs
add-in security options, 368
alignment, changing, 146
borders, applying or deleting, 152
Chart Elements list arrow, 269
Developer tab

setting options, 453
showing/hiding, 389

maximizing/minimizing, 4, 6
using, 4

right-alignment of objects, 253
R1C1 reference style, 437
roundtripping, 472
rotating. See also pictures; 3-D rotation

gradients, 245
objects, 257
Picture Manager, editing in, 443
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rotating (continued)
shapes, 257
with SmartArt graphics, 220
WordArt text, 215

Row Differences option, 38
rows. See columns and rows
ruler units, setting, 433
Run dialog box in safe mode, 377

S
Safe for Initialization (SFI) controls, 369
safe modes

automated safe mode, 376-377
enabling, 376
user-initiated safe mode, 376-377

saturation of color, defined, 159
Save as type

list, 396
macros, saving, 462

Save button, 22
Save dialog box, 22-23
Save Workspace command, 127
saving. See also workbooks; XML

(Extensible Markup Language)
Document Management Servers

(SharePoint server), workbooks to,
498

in HTML (Hypertext Markup Language),
411

older version workbooks, 23
PDF documents, workbooks as, 185
setting options, 23
shapes as pictures, 198
Web queries, 424
workspace layout, 127

Scale to Fit Dialog Box Launcher, 181
scaling

paper sizes, 436
pictures, 202-203
print scaling, changing, 172-173

scanning
pictures, 195

scenarios
creating, 330
showing, 331
summaries, creating, 331

scientific format, 43
scope, names for, 84

Screen shot, inserting, 196
ScreenTips

for add-in security options, 368
for dialog box options, 8
for functions, 433
for hyperlinks, 415
for macros, 461
style, selecting, 428
for themes, 157
turning on/off, 6

scroll bars
for Active controls, 466
showing, 434
synchronizing scrolling of documents, 19

searching. See also clip art; finding and
replacing

for cell values, 123
conditional formatting, cells with, 143
for help, 21
tables, custom searches of, 309
for themes, 156

security, 349. See also digital signatures;
passwords; Trust Center

Active controls security settings, 369
add-in security options, 368, 449
for cell styles, 167
data connections, security settings for,

374
external content security options, 

374-375
for external data, 403
file encryption, adding, 355
formulas, showing/hiding, 354
harmful attacks, avoiding, 362-363
locking/unlocking cells, 354
of macros, 352, 370
Message Bar security options, changing,

371
safe modes, 376-377
for shared workbooks, 385
XML data maps, 390

Select All button, 153
selecting

borders, 153
cells, 37
columns and rows, 38, 116
contiguous cells, 37
hyperlinks, 415
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multisheet ranges, 39
noncontiguous cells, 37
ranges, 39
special ranges, 39
tables, columns and rows in, 302
worksheets, 110

Selection Mode Status bar, 9
Selection pane for objects, 255
Send to Back

objects, 255-256
with SmartArt graphics, 220

Send2Fax, 387
sepia mode for pictures, 206
series lines, 285
shadows

in charts, 274, 275
for data series, 283
to pictures, 201
to shapes, 247, 251
to SmartArt graphics, 225
for text, 134-135
to WordArt text, 214

Shape Effects gallery, 224, 246
Shape Fill button, 224, 240
shape fills

to charts, 275
color fills, 241
gradient fills, applying, 244-245
picture fills, 242

Shape Outline button, 224
for lines or arrows, 234-235

shape outlines, 224, 234-235, 241
to charts, 275

Shape Quick Style, 234, 238
for connecting shapes, 254
to text, 239

shapes, 229, 246-247. See also SmartArt
graphics

adjusting, 231
applying shapes to pictures, 199
in charts, 275, 287
Clip Organizer, adding to, 260
colors

fills, adding, 240-241
outlines, applying, 241

connecting, 254
customizing creation of, 440

deleting, 230
color fills, 240

drawing, 230
flipping, 257
freeforms, converting to, 236
gradient fills, applying, 244-245
grouping/ungrouping, 258-259
individual effects, adding, 247
multiple shapes, inserting, 232
organization chart, adding to, 227
other shapes, changing to, 232
picture fills, applying, 242
presets, adding, 246
proportional shapes, drawing, 230
replacing, 231
resizing, 230-231
rotating, 257
saving as pictures, 198
shadows, adding, 247, 251
textures, 243
3-D effects, adding, 248-249
3-D rotation, adding, 250
transparency, applying color fill with,

241
shape text, 233

Quick Styles, adding, 239
shared workbooks, 379, 380-381. See also

comments
e-mailing shared workbooks, 386
enabling sharing, 380
faxing workbooks, 387
options for sharing, changing, 381
security for, 385
tracking changes in, 384-385

SharePoint, 1, 295. See also Groove
Groove 

alerts, 496
creating workspaces, 494-495
invite others to use, 497
manage Document tools, 496
sharing files with, 496

Office Mobile, 500
Microsoft SharePoint Workspaces, 

494-497
Server

co-authoring documents, 499
opening from, 499
saving to, 498
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SharePoint (continued)
shared folder, 494
tables, exporting, 324
workspaces, 494-495

sharing. See also shared workbooks
Groove, files in, 494-496
OLE (object linking and embedding) and,

394-395
SharePoint, files in 494-495

Shockwave Flash Object Active control, 469
Shortcut menu

commands from, 5
group-related commands, 258

shortcuts, 4
from Start menu, 2

short date format, 43
showing/hiding. See also tables; workbooks

chart data tables, 280-281
columns and rows, 117
Document Inspector and, 350-351
formulas, 354
objects, viewing, 256
Text pane, 218
worksheets, 114

shrinking text to fit, 148
signatures. See also digital signatures

Status bar, checking with, 9
visible signature line, adding, 360-361

Signatures task pane, 358
Single File Web Pages, 417, 418-419
size. See resizing
Size and Position dialog box

for pictures, 202-203
Size Dialog Box Launcher, 202-203

shapes, resizing, 230
SkyDrive. See Windows Live
Slicer

creating, 316
deleting, 316
local slicer, 316
PivotChart, 318
PivotTable, 316-317
shared slicer, 316-317
Stand-alone slicer, 317
sharing, 317
using, 316-317

SLK format, 25
SmartArt graphics. See also organization

charts
adding shapes to, 220
arranging shapes in, 221
changing shapes in, 220
colors, changing, 223
creating, 216
deleting shapes from, 219
editing shapes in, 221
effects, applying, 225
fills, applying, 224
formatting, 222-223

shapes, 224-225
layouts, changing, 223
orientation, changing, 222
outlines for, 224
picture graphic layouts, 226
placeholder text in, 217
purposes, 217
Quick Styles, applying, 222
resizing, 221
text, converting, 217
Text pane with, 218-219

soft edges
to charts, 275
to organization charts, 228
to pictures, 201
precedence of, 246
to shapes, 247, 248-249
to SmartArt graphics, 225

Solver, 325, 447
using, 332-333

sorting
cell names, 88
data, 295
fields, 306-307
tables, data in, 306

sounds
feedback with, 436
inserting, 189

source files, 394
spam, 362
sparkline formatting, 144-145
spell-checking, 62

dictionaries, customizing, 64-65
foreign languages, 444
proofing options, changing, 63

Spelling dialog box, 62
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Spin button for Active controls, 466
splitters, 15
splitting worksheets into panes, 123
spoofed Web sites, 362-363
Spotlight workbook templates, 11
spyware, 362
squares, drawing, 230
stacking order, changing, 256
standard modules in VBA (Visual Basic for

Applications), 451
standard tabs, 4
starting

Excel, 2
Groove, 494-495
SharePoint Workspaces, 494-495

Start menu, 2
Groove, launching, 494

Statistical functions, 345
Status bar

calculations, displaying, 91
controls, 3
using, 9

STDEV or STDEV.S functions, 83
step mode, debugging macros with, 458
storing

cell contents, 49
data in Excel, 16

straight connectors, 254
straight lines, drawing, 234
strikethrough text, 134-135
styles. See also cell styles; charts; Quick

Styles
ScreenTip styles, selecting, 428

sub procedures in VBA (Visual Basic for
Applications), 451

subscript text, 135
SUBSTITUTE function, 336
subtotals

calculating, 92-93
list, data in, 337
in PivotTable reports, 313

SUM function, 71, 102. See also Conditional
Sum Wizard

automatic calculations, 91
subtotals, calculation of, 337

SUMIF function, 338-339
summarize data functions, 338-339
superscript text, 135

surfaces
for data series, 283
shapes, adding to, 248-249

switching
between views, 29
between windows, 19

SYLK files, opening, 13
symbols, inserting, 66
synchronizing. See also Groove

scrolling of documents, 19
synonyms, 67
syntax for VBA, 450

T
Tab key for selecting objects, 258
tables, 295. See also PivotTable

Access table into workbook, exporting,
408

AutoFilter, displaying parts with, 308
banded columns and rows in, 300
calculations in, 301
chart data tables, showing/hiding, 280-

281
clearing, 297
copying cell formats, 298
creating, 297
definitions, 296
deleting, 297

columns and rows, 304
duplicate rows, 304
styles, 298, 299

drop-down list, entering data from, 305
duplicate rows, deleting, 304
elements, formatting, 300
first column, formatting, 300
formatting, 298

elements of table, 300
formulas, table names in, 437
inserting columns and rows in, 302
last column, formatting, 300
multiple fields, sorting data using, 307
names, 84
one-input data table, creating, 328
printing, 298
Quick Styles, applying, 298
range, converting to, 302-303
resizing, 302-303
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tables (continued)
searches, creating, 309
selecting columns and rows in, 302
SharePoint lists, exporting tables to, 324
showing/hiding

chart data tables, 280-281
elements, 300

sorting data in, 306-307
styles

creating or modifying, 299
Quick Styles, applying, 298

ungrouping, 258
Table tab, 4
tabs, 3, 4

colors, adding or removing, 154
dialog box options, 8
displaying, 434

task panes, 15. See also specific types
templates. See also charts

changing, 130
creating, 128
customizing, 130
default templates, 129
Document Information Panel template,

selecting, 470
locating, 129
macro-enabled templates, 462
opening, 129
for workbooks, 11

text. See also charts; shape text; WordArt
columns, converting to, 321
concatenation, 73
customizing creation of, 440
flow of text, controlling, 148
formatting, 134-135
for hyperlinks, 416
labels, entering, 40
SmartArt graphics, converting to, 217
themes, text colors in, 156
translating text, 69
wrapping text in cells, 74, 148

text boxes, 8
for Active controls, 466
in charts, 287
creating, 233

Text Effects gallery, 214
text files

importing, 397, 410

opening, 13
retrieving data from, 403

Text functions, 104, 336
Text pane

for organization charts, 227
showing/hiding, 218
with SmartArt graphics, 218-219
tasks with text in, 219

texture fills, 243
textures in WordArt, 212-213
themes, 131, 156

accent colors, 156
applying, 157
background colors, 156
custom themes

choosing and applying, 164
creating, 163
files, selecting and applying from, 165
selecting, 159

deleting
custom color themes, 159
Document Themes folder, custom

themes from, 164
effects, 162
fonts, 162

Document Themes folder, 163-164
effects, choosing, 162-163

existing color theme, changing, 158
files, selecting and applying themes

from, 165
fonts, 160-161

deleting, 162
hyperlink colors, 156
other programs, use in, 157
text colors, 156
viewing, 157

effects, 162
thesauruses, 67

Research task pane for accessing, 68
3-D cell references, 80

creating, 83
3-D effects. See also 3-D rotation

in charts, 274, 286
for data series, 283
precedence of, 246
to shapes, 248-249

3-D rotation
to charts, 275
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to organization charts, 228
to pictures, 201
precedence of, 246
to shapes, 247, 250
to SmartArt graphics, 225
to WordArt text, 214

tick marks
changing, 276
editing, 267

tilde (~), 336
times. See dates and times
titles. See charts
toggle buttons for Active controls, 466
toolbars. See also Mini-Toolbar; Quick

Access Toolbar
working with, 6-7

tooltips for functions, 72
top-alignment of objects, 253
tracer arrows, 100
tracing worksheet relationships, 100
Track Changes feature, 384-385

accepting/rejected tracked changes, 384-
385

transform effect for WordArt text, 214
translating text, 69
translucent surfaces for shapes, 248-249
transparency

for picture backgrounds, 207
shape color fill with, 241

trendlines, 285
Trojan Horse, 362
TrueType fonts, 135
truncating long labels, 41
Trust Center, 349. See also macros

Active controls security settings, 369
add-in security options, setting, 368
documents, 366-367
locations, selecting, 365
parental controls, setting, 373
Privacy Options, 363

parental controls, setting, 373
setting, 372-373

publishers, selecting, 365
safe modes, enabling, 376-377
viewing, 364

Trusted Documents, 366-367
TuCows, 363
turning on/off

AutoComplete option, 41
Formula AutoComplete, 77
ScreenTips, 6
Track Changes feature, 384

two-input data table, creating, 328

U
underlining comments, 383
Undo feature, 35, 70

in Picture manager, 443
pie chart explosion, 282
for shape fills, 240

ungrouping. See grouping/ungrouping
unhiding. See showing/hiding
Uniform Resource Name (URN), 470
Universal Data Connection (UDC) files, 404
Universal Naming Convention (UNC), 470
up/down arrows, 8
UPPER function, 336
URLs (Uniform Resource Locators), 413,

470
Use in Formula command, 86-87
user-initiated safe mode, 376-377
Use row and column names option, 87

V
validation, adding, 322
values, 36. See also scenarios

AutoFill, entering with, 44-45
deleting values, keeping formulas, 96
entering, 42-43
formatting, 43
formulas, converting, 85
searching for, 123

VAR functions, 83
VBA (Visual Basic for Applications), 445.

See also macros
Active controls, adding code to, 468
definition of terms, 450
enhancing workbooks, 450
modules, 451
procedures, 451
projects, building, 451
structure of, 450
viruses, avoiding, 362-363
writing code, 450

vector images, 188
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vertical alignment, 146-147
of WordArt text, 215

vertical page breaks, 178
view buttons, 3
viewing. See also Groove; themes; work-

books; zooming
add-ins, 446
clips on Web, 190
digital signatures, 359
display view options, setting, 433
Excel window, 3
hidden objects, 256
safe mode, disabled items in, 377
switching between views, 29
Trust Center, 364
Visual Basic Editor, 452
workbook document properties, 28
XML documents, 388

View tab, 4
Viewer, Excel software, 12
viruses, avoiding, 362-363
Visual Basic Editor, 451-452

viewing, 452
Visual Basic for Applications. See VBA

(Visual Basic for Applications)
VLOOKUP function, using, 334
VML, Web pages allowing, 417

W
washout mode for pictures, 206
Watch window

deleting cells from, 98
formula errors, correcting, 98

watermarks, inserting, 177
Web cameras, inserting pictures from, 195
Web pages

appearance, changing, 412
Check Office Documents that are from or

link to suspicious Web sites option,
363, 372

copying Web table to worksheets, 421
hyperlinks to, 414
interactive Web page, publishing work-

sheet as, 420
opening workbook as, 412
options, changing, 417
previewing, 413
refreshable Web queries, creating, 422

saving worksheets/workbooks as, 418-
419

as Single File Web Pages, 417, 418-419
spoofed Web sites, 362-363

Web servers, 420
What-If Analysis button, 328

Goal Seek with, 329
width of columns, adjusting, 120-121
wildcard characters, 336
window panes, 15

worksheets, splitting, 123
windows

arranging, 18-19
copying contents of, 198
side by side comparisons, 19
switching between, 19

Windows Explorer
exclusion dictionaries, finding, 65
starting Excel from, 2

Windows Live
adding files to, 486
copying documents, 487
creating documents, 485
deleting documents, 487
downloading files, 488-489
embedding links, 492-493
moving documents, 487
opening documents, 476-477
renaming documents, 487
saving documents, 476-477
sending links, 492
SkyDrive

browsing folders, 480-481
creating folders, 482
deleting folders, 483
renaming folders, 483
setting folder permissions, 484

Windows Live ID, 471-472, 474-475
sign-in, 475

Windows Mobile, 500
Windows Rights Management XPS compat-

ibility, 186
wire frame surfaces for shapes, 248-249
WMF format, 188
WordArt, 187

deleting text, 211
direction of text, changing, 215
effects, applying, 214
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formatting text, 212-213
inserting, 211
rotating text, 215
styles, 212-213

WordArt Quick Style gallery, 211
for shape text, 239

Workbook Connections dialog box, 404-405
workbooks, 1. See also links and linking;

read-only workbooks; security; shared
workbooks; VBA (Visual Basic for
Applications); Web pages; worksheets

AutoRecover for, 31
blank workbooks, 10
closing, 34
Compatibility Checker for, 26
consolidating data, 400-401
converting existing workbooks, 14
custom views, creating, 126
deleting custom views, 126
diagnosing problems, 32
display options, setting, 434
Document Management Servers

(SharePoint server), 
workbooks to, 498

elements, showing/hiding, 124
e-mailing shared workbooks, 386
existing workbooks

converting, 14
opening, 12-13

faxing workbooks, 387
file encryption, adding, 355
final, marking as, 378
HTML (Hypertext Markup Language),

saving in, 411
hyperlinks within, 414
inspecting documents, 350-351
keyboard, navigating with, 17
macros

opening workbook with, 463
saving workbook with, 462

modifying, 109
names for, 10
navigating in, 16-17
new options, changing, 429
Office Web App, creating, 485
opening, 12-13

with macros, 463
passwords for, 356-357

PDF format
saving workbooks in, 185
sending workbooks in, 386

properties, viewing and editing, 28
recently opened workbooks, opening, 13
recovering, 30-31
repairing problems, 32
saving, 22-23

different formats, workbooks 
with, 24-25
with macros, 462
older version workbooks, 23

showing/hiding, 114-115
custom views, 126
elements of workbook, 124

as Single File Web Page, 418-419
specific location, navigating to, 17
templates for, 11
tracking changes, 384-385
viewing

custom views, creating, 126
in full screen, 124

window, 3
Windows Explorer, opening from, 2
XPS documents, saving as, 186
zooming on, 125

worksheets, 1. See also formatting; page
layout; printing; tables; themes; Web
pages

all worksheets, selecting, 110
auditing, 100
backgrounds, changing, 112
charts, linking, 278
colors of tab names, changing, 115
consolidating data, 400-401
copying, 112-113
data validation, adding, 322
deleting, 111
designing, 131
display options, setting, 434-435
entire worksheet, selecting, 116
groups, forming, 112
hiding/unhiding, 114
inserting, 111
inspecting information in, 351
links, creating, 402
modifying, 109
moving, 112
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worksheets (continued)
naming, 110
numeric formats, 132-133
panes, splitting into, 123
passwords for, 352-353
previewing, 171, 183
renaming, 110
selecting, 110
as Single File Web Page, 418-419
specific number of pages, fitting on, 181
splitting into panes, 123
tabs, controls on, 4
tracing relationships in, 100
Web tables, copying, 421

workspace. See also Groove
layout, saving, 127
opening workspace files, 127

worms, avoiding, 362-363
wrapping text in cells, 74, 148

X
X-axis. See chart axes
XLA format, 25
XLAM format, 25
XLSB format, 25
XLS format, 24-25
XLSM format, 25
XLSX format, 25
XLT format, 25
XLTM format, 25
XLTX format, 25, 128

XML (Extensible Markup Language), 1, 25,
379

data maps
creating, 390
properties, changing, 389

expansion packs, adding, 391
exporting data in, 392
importing XML data, 391
inspecting documents, 350-351
opening files, 13, 393
saving

data in XML format, 392-393
workbooks as XML file, 22

working with, 388-389
XML Schema, 379

attaching, 388
XML Source task pane, 388, 390
XPS format, 1, 25

saving workbooks as, 186
workbooks sent as, 386

Y
Y-axis. See chart axes

Z
zero value cells, 435
zip file, creating, 488-489
zooming

on chart objects, 269
controls, 3
with IntelliMouse, 16
on name range, 88
in workbooks, 125
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